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About SolarWinds 

SolarWinds, Inc develops and markets an array of network management, monitoring, and discovery 
tools to meet the diverse requirements of todayôs network management and consulting professionals. 
SolarWinds products continue to set benchmarks for quality and performance and have positioned 
the company as the leader in network management and discovery technology. The SolarWinds 
customer base includes over 45 percent of the Fortune 500 and customers from over 90 countries. 
Our global business partner distributor network exceeds 100 distributors and resellers. 

Contacting SolarWinds 

You can contact SolarWinds in a number of ways, including the following: 

Team Contact Information 

Sales 1.866.530.8100 

http://www.solarwinds.com 

User Forums http://www.thwack.com contains the community oriented user 
forums 

Technical Support 
support.solarwinds.net/support you need a customer account to 
access the Customer Support area of the website. 

 

Conventions 

The documentation uses consistent conventions to help you identify items throughout the printed and 
online library. 

Convention Specifying 

Bold Window items, including buttons and fields. 

Italics Book and CD titles, variable names, new terms 

Fixed font  
File and directory names, commands and code examples, text 
typed by you 

Straight brackets, as in 
[value] 

Optional command parameters 

Curly braces, as in {value} Required command parameters 

Logical OR, as in 
value1|value2 

Exclusive command parameters where only one of the options 
can be specified 

 

http://www.solarwinds.com/
http://www.thwack.com/
http://support.solarwinds.net/support
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ipMonitor Documentation Library 

The following documents are included in the ipMonitor documentation library: 

Document Purpose 

Administrator Guide Provides detailed setup, configuration, and conceptual 
information. 

Page Help Provides help for every window in the ipMonitor user 
interface 

QuickStart Guide 
Provides installation, setup, and common scenarios for 
which ipMonitor provides a simple, yet powerful, 
solution. 

Release Notes 
Provides the latest information about known issues, 
and updates. The latest Release Notes can be found at 
http://www.solarwinds.com.  

 

 

 

 

 

 

 

 

 

 

http://www.solarwinds.com/
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Chapter 1 

Introduction 

ipMonitor provides a proven agentless architecture as a backbone for a  
comprehensive feature set. Reliable data collection and tested ease of use 
makes ipMonitor the ideal network monitoring solution for your small to medium 
business. 

ipMonitor not only provides the tools you need to proactively Monitor your 
network from end to end, it also includes the necessary alert types to notify you 
in the event of trouble and automatically recover critical applications, servers and 
infrastructure devices whenever possible. 

Monitoring 

ipMonitor proactively discovers your critical network resources and tracks their 
availability, responsiveness and performance quality. It monitors the health of:  

¶ Business and web applications, such as SQL databases, web servers, 
commerce, and mail servers. 

¶ Infrastructure equipment such as server computers, switches, routers and 
power back-up systems. 

¶ Services including IP-based services and Windows services. 

ipMonitor offers more than 55 different monitor types:  

¶ User experience monitors that perform multiple transaction tests to measure 
response time and analyze results for critical applications and infrastructure 
equipment. 

¶ Windows NT/2000/XP/2003/2008 system monitors specifically designed to 
monitor key systems, such as services and event logs. 

¶ Resource monitors that monitor finite system resources, and then alert 
before consumption becomes critical. 

¶ Availability monitors that support all popular OSI layer 7 (Application Layer) 
protocols based on IP networking. 

¶ SNMPv2 trap support along with SNMPv1 traps. 

¶ Exchange 2007 Monitor. 

¶ WMI Generic Windows Monitor 
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Alerting 

When quality of service degrades, thresholds are exceeded, or failures occur, 
ipMonitor provides a comprehensive suite of alerting tools:  

¶ Alert actions offer industry standard methods to alert responsible individuals: 

o by phone using email or SMS. 

o by numeric or alphanumeric pager. 

o by wireless device using email or net broadcast. 

¶ Integration actions allow for integration with other applications such as 
network management solutions, ticket systems, and custom recovery 
applications. 

¶ Recovery actions allow you to automatically initiate recovery procedures. 

Recovery 

Each monitor supports the ability to set operating environment variables. Alerts 
use these variables when a problem is detected. During a failure, corrective 
action is taken immediately using ipMonitor's recovery actions:  

¶ Restart failed applications, perform diagnostics, back up files, run scripts, 
and so on. 

¶ Reboot the server or workstation. 

¶ Restart a list of services on a specific remote machine, including services 
with dependencies. 

Reporting 

ipMonitor offers in-depth visual analysis of your monitor statistics. Detailed 
reports allow you to see equipment performance:  

¶ Dashboard and Network Operation Center (NOC) views that provide at-a-
glance reports for all personnel who manage the network. 

¶ Configurable data analysis reports in both graphical and tabular formats. 

¶ Quick reports offer instant access to statistics data recorded by any monitor 
or group. 

¶ Zoomable reports allow you to explore deep into the ipMonitor database of 
test results to easily identify the error messages that triggered alerts. 

¶ Email reports offer distribution to single or multiple recipients. 

ipMonitor thwack integration  

¶ Provides the most recent thwack community forum posts and file uploads for 
ipMonitor. 
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Chapter 2 

Installing SolarWinds ipMonitor 

The following sections help to ensure you have the appropriate system 
requirements, and then guide you through installing ipMonitor. 

System Requirements 

The following minimum system requirements must be met to successfully run 
ipMonitor: 

Software Requirements 

Operating System 

A 32-bit or 64-bit version of one of the following: 
Windows Vista (IPv4 mode only) 
Windows XP SP2 or later  
Windows Server 2003 SP1 and R2 
Windows 2008 R2 

Web Browser 
Microsoft Internet Explorer 6 or later 
Firefox 1.5 or later. 

Hardware ~500 monitors 

CPU Speed Single core 2.0 GHz 

Hard Drive Space 240MB 

Memory 512MB 
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Optional System Requirements 

Some advanced features of ipMonitor have additional requirements as follows: 

Optional Feature Requirements 

Modem and Telephony 

For Simple beeper, SMS TAP, and SMS 
UCP  alert actions: 

¶ Hayes-compatible 1200 baud or faster 
hardware modem. 

¶ Dedicated telephone line or a 
telephone system that is always able to 
free up an outbound telephone line on 
demand. 

 
For SMS GSM alert actions: 

¶ Hayes-compatible GSM/GPRS modem 

¶ GSM Mobile Network subscription 

SSL Certificates 

Valid certificates: 

¶ Self-signed certificates 

¶ CA certificates such as VeriSign  

¶ Microsoft Windows 2000 certificate 
services 

Note: After installed, available certificates 
are selected from the Local Machine 
certificate store. 

ADO and ADO User Experience monitors 

MDAC Version 2.6 SP2.or later. MDAC is 
now called WDAC for Windows 2008. 
http://msdn.microsoft.com/en-
us/library/ms810810.aspx 
 

Installing ipMonitor 

The following procedure guides you through installing ipMonitor. 

Complete the following procedure to install ipMonitor: 

1. Log on to the server on which you want to install ipMonitor. 

2. If you downloaded the install file, click the exe.  

3. If you received physical media, browse to the executable file, and then launch 
the executable. 

4. Review the Welcome text, and then click Next. 

5. Accept the terms of the EULA and then click Next. 

6. Provide a user name and organization name and then click Next. 

7. To select a different install location, click Change and navigate to the desired 
destination folder and then click Next. 

8. Click Install on the Ready to Install Program window. 

9. Click Finish to launch the ipMonitor Configuration Program. 

http://msdn.microsoft.com/en-us/library/ms810810.aspx
http://msdn.microsoft.com/en-us/library/ms810810.aspx
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Note: It is recommended that you do not install ipMonitor on a domain controller. 
To take full advantage of ipMonitor's security features, we suggest that you 
create an account specifically for the ipMonitor Service to run under that applies 
the minimum tokens required by the ipMonitor Service to operate successfully. 
However, when ipMonitor is installed on a domain controller, the Credential 
Manager cannot be enabled to impersonate Windows accounts with elevated 
permissions. There is no allowance for trust relationships outside of the domain, 
resulting in limited access to many ipMonitor features. 

After installing the software through the setup wizard and completing the 
Configuration Wizard, you are prompted to enter the license activation key for 
your product. If you do not have an activation key, the product runs in a time-
limited evaluation mode. 

To evaluate the software without a license: 

Click Continue Evaluation. 

Licensing ipMonitor 

 

To license the software on a server with Internet access: 

1. Click Enter Licensing Information. 

2. Select I have internet access and an activation key. 

3. Click the http://www.solarwinds.com/customerportal link to access the 
customer portal on the SolarWinds web site. 

4. Log on to the portal using your SolarWinds customer ID and password. 

5. Click License Management on the left navigation bar. 

6. Navigate to your product, choose an activation key from the Unregistered 
Licenses section, and then copy the activation key. 

7. If you cannot find an activation key in the Unregistered Licenses 
section, contact SolarWinds customer support. 

8. Return to the Activate ipMonitor window, and then enter the activation key in 
the Activation Key field. 

9. If you access Internet web sites through a proxy server, click I access 
the internet through a proxy server, and enter the proxy address and port. 

10. Click Next. 

11. Enter your email address and other registration information, and then click 
Next. 
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To license the software on a server without Internet access: 

1. Click Enter Licensing Information 

2. Select This server does not have internet access, and then click Next. 

3. Click Copy Unique Machine ID. 

4. Paste the copied data into a text editor document. 

5. Transfer the document to a computer with Internet access. 

6. On the computer with Internet access, complete the following steps: 

7. Browse to 
http://www.solarwinds.com/customerportal/licensemanagement.aspx and 
then log on to the portal with your SolarWinds customer ID and password. 

8. Navigate to your product, and then click Manually Register License. 

9. If the Manually Register License option is not available for your product, 
contact SolarWinds customer support. 

10. Provide the Machine ID from Step 5, and then download your license key file. 

11. Transfer the license key file to the server. 

12. Return to the Activate ipMonitor window, browse to the license key file, and 
then click Next. 

Maintaining Licenses with License Manager 

SolarWinds License Manager is an easily installed, free utility that gives you the 
ability to migrate Orion licenses from one computer to another without contacting 
SolarWinds Customer Service. The following sections provide procedures for 
installing and using License Manager. 

Installing License Manager 

Install License Manager on the computer from which you are migrating currently 
licensed products. 

Note: You must install License Manager on a computer with the correct time. If 
the time on the computer is off by as little as 5 minutes, in either direction, from 
Greenwich Mean Time (GMT), you will be unable to reset licenses without calling 
SolarWinds Customer Service. Time zone settings do not affect and do not 
cause this issue. 
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To install License Manager: 

1. Navigate to http://support.solarwinds.com/support/default.cfm. 

2. Provide your SolarWinds Customer ID and password, and then click Login. 

3. Click Downloads &  Updates in the left navigation pane. 

4. Locate the Download Licensed Software section of the page, and click 
SolarWinds License Manager. 

5. Unzip the downloaded file, and then run LicenseMan ager.exe . 

Using License Manager 

You must run License Manager on the computer where the currently licensed 
SolarWinds product is installed before you can move licenses to a new 
installation. The following procedure deactivates currently installed licenses that 
can then be transferred to a new installation. 

To deactivate currently installed licenses: 

1. Click Start > All Programs > SolarWinds > SolarWinds License Manager. 

2. Check products to deactivate on this computer, and then click Deactivate. 

3. Specify your SolarWinds Customer ID and password when prompted, and 
then click Deactivate. 

Note: Deactivated licenses are now available to activate on a new computer. 

When you have successfully deactivated your products, log on to the computer 
on which you want to install your products, and then begin installation. When 
asked to specify your licenses, provide the appropriate information. The license 
you deactivated earlier is then assigned to the new installation. 

 

Configuring ipMonitor 

The ipMonitor Configuration program helps you configure several key parameters 

for the ipmonitorsrv  ipMonitor service: 

http://support.solarwinds.com/support/default.cfm
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¶ Entering an IP address and port number on which the web interface listens. 

¶ Selecting an SSL certificate for secure communication. 

¶ Changing the Windows Service account context. 

First Run Mode 

After you first install ipMonitor, the Configuration program automatically runs in 
"First Run" mode: 

¶ Gets you up and running quickly. 

¶ Runs once. 

¶ Automatically provides default parameters. 

¶ Requires you to configure an ipMonitor administrator account. 

This initial configuration process allows you to set up the following default 
Monitors, allowing you to begin testing your system resources immediately: 

¶ CPU usage monitor  

¶ Memory usage monitor  

¶ Drive Space monitor  

In addition, the First Run mode creates a default group, alert, and email action, 
and associates them with the new Monitors. 

Running the ipMonitor Configuration Program 

To start the ipMonitor Configuration program: 

1. Click Start > All Programs > SolarWinds ipMonitor > Configure 
ipMonitor. 

2. If the ipMonitor Service is not running, you are prompted to Launch 
the ipMonitor Service. 

 3. Click Yes to start the Service. 

Note: The Configuration Program is not used to add or configure monitors, 
alerts, or actions. The addition or modification of ipMonitor elements is done 
through the ipMonitor Web Interface. 

Using Express Discovery 

Express Discovery assists in adding commonly used monitors in a quick and 
easy wizard-driven user interface. For new installs the Express Discovery will 
begin after the initial web interface login. 
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By default the most common monitors are added; CPU Usage, Memory, Usage, 
Drive Space, Bandwidth Usage, Ping, HTTP, HTTPS, Windows, Exchange 
Server 2000/2003, Exchange Server 2007/2010, SQL Server, Active Directory. 

To enable the Express Discovery: 

1. Log on to the ipMonitor web interface with your administrator account 
username and password. 

2. Click Devices and then select Discovery Express Scan 

3. Select which applications and resources to monitor and then click Next.  

4. Enter IP Ranges. In the Start Address and End Address text boxes, type 
the start and end of an IP address range to scan for devices and click Next.  

Note: Scanning a large IP address range may take a long time. In the 
interest of providing you with a quick start, please select only a small IP 
address range of 100 addresses or less for your initial scan. 

5.  If you have Windows network credentials you want to use for 
discovering Windows network resources, complete the following 
procedure: 

a. Click Next to open the Credentials window. 

b. Click New Credential to launch the Credentials Wizard. 

c. In the Credential Name text box, type a name for the credential, and 
then click Next. 

d. Type the details of your Windows network credential in the Account, 
Password, and Confirm Password text boxes, then click Next. 

e. Click Credential may only be used by my Account, and then click 
Next. 

f. Click Finish. 

g. Click Apply. 

 . If you have SNMP community strings you want to use for 
discovering SNMP devices and resources, complete the following 
procedure: 

a. In the SNMP Credential text box, type the SNMP community string. 

b. If you want to specify additional SNMP community strings, click Add 
SNMP Community to create additional entries. 

6.  Click Next to begin Discovery Scan and then wait for the device scan to 
finish. 

7.  Wait for a few scans to finish. Scans are finished when the device state 
changes from Scanning device to Scanning Complete. 
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8.  Click Add All Scanned Devices. 

9.  A tab appears on the Dashboard containing the scan results summary. 

 

10.  Select Show Alert List to review the added alerts.  

11.  Click  Go to Dashboard. The Dashboard page appears, summarizing 
the current network state. 

Note: User experience monitors must be added manually because critical 
information in each monitor is specific to each network environment 

Adding ipMonitor Administrator Accounts 

The Administrator Account window is used to add administrator accounts to 
ipMonitor. Accounts added here are strictly internal to the ipMonitor software, and 
are not associated with Windows local machine or domain accounts. 

The first Administrator Account must be created from the ipMonitor Configuration 
program. The following rules apply to Administrator accounts:  

¶ Administrator accounts cannot be deleted until they are demoted within the 
ipMonitor Administration web interface to a general user. 

¶ There must always be at least one administrator account. 

¶ Administrator accounts cannot delete themselves, nor can they demote 
themselves. 

To create a new Administrator account 

¶ Click Add Account. 

Note: All account information is stored internally using RSA 512/1024 bit 
encryption. 

 

Communications: Web Server Ports 

From this window, you can:  
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¶ Configure the IP Address and Port combinations for the ipMonitor web 
interface to listen on. 

¶ Set the IP Address and Port combination ipMonitor uses to listen for 
incoming SNMP Traps. 

HTTP Server TCP Settings 

ipMonitor requires that one or more IP Address and Port combinations be 
assigned to it in order to enable communication via the HTTP and HTTPS 
protocols. These are the protocols you use to log in and administrate ipMonitor. 

Use the Communications: Web Server Ports window to enter any number of 
Port combinations for ipMonitor to listen on. The Delete button may be used to 
remove an entry, while the Edit button allows you to make modifications to an 
entry. Click the Add button to add additional IP Address and Port combinations. 

For each HTTP entry: 

¶ Type an IP Address and Port combination that is not used by any other 
server application. 

For each HTTPS entry: 

1. Type an IP Address and Port combination that is not used by any other 
server application. 

2. Select the Enable SSL check box. This option requires an SSL Server 
Certificate to be assigned to your ipMonitor installation. 

To have ipMonitor listen on all IP Addresses bound to the host machine on a 
specific Port, enter an IP Address of 0.0.0.0. For example, a value of 
[0.0.0.0][8080] makes ipMonitor listen on every IP Address assigned to the 
machine on port 8080. 

Note: If other HTTP Services are installed on the ipMonitor host machine, verify 
that their IP Address and Port settings do not conflict with ipMonitor Port settings. 
For example, another HTTP Service might use the default port 80. 

ipMonitor is a stand-alone HTTP server. It does not integrate into or require other 
web server Services such as IIS (Internet Information Server). 

You can generate and assign a Self-Signed Certificate using the Secure Socket 
Layer Certificate options in the Configuration program. Self-signed certificates 
are free. 
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Configuring the SNMP Trap Listener 

Any SNMP Trap Monitors created in ipMonitor uses the IP Address and Port 
combination entered in the SNMP Trap Listener section to listen for incoming 
SNMP Traps. 

The SNMP - User Experience Trap monitor is an event-based, non-polling 
monitor. The monitor listens for SNMP Traps sent to it by any number of SNMP 
agents on the network. Each incoming Trap is parsed and compared to the 
settings of the existing SNMP Trap monitors to determine whether an Information 
alert action should be triggered. 

To listen to all IP Addresses on a specific port, type an IP address of 0.0.0.0. 
ipMonitor listens to every IP Address on that port. 

For example: [0.0.0.0][162] 

Port 162 is the standard SNMP listening port. 

Note: Any SNMP agents that are expected to send Traps to ipMonitor must be 
configured to send Traps to the IP address and port specified here. 

If the SNMP Trap Listener is not enabled, SNMP Trap Monitors do not work, 
even if the Monitor itself is enabled. 

Note regarding Windows SNMP Trap Service:  

If the Windows SNMP Trap service is enabled on the ipMonitor host computer, it 
is very likely to conflict with ipMonitor's SNMP Trap Listener. Both are bound by 
default to port 162. 

To resolve conflicts with the Windows SNMP trap service: 

¶ Change ipMonitor's SNMP Trap Listener port to one that is unused, then also 
change the outbound port of all the SNMP agents sending Traps to 
ipMonitor. 
-or- 

¶ Disable the Windows SNMP Trap Service from the Windows Control 
Panel/Services interface. There are no adverse effects to disabling the 
Windows SNMP Trap service unless you are running another SNMP solution 
on the ipMonitor server that requires use of the Windows SNMP Trap 
service. 

Communications: Lockout 

The Communications: Lockout dialog box is used to specify the IP addresses 
that ipMonitor communicates with. 

IP Access Filters are an optional security feature that allow you to either:  



ipMonitor Ö Administration Guide 
 

 
Configuring ipMonitor Ö 27 

¶ Limit communications to a set of IP Addresses or ranges of IP Addresses. 

¶ Exclude a list of IP addresses or ranges of IP addresses from communicating 
with ipMonitor. 

Click the Add button to add a new entry. Your entries may consist of single IP 
addresses or ranges of IP addresses. The Delete button may be used to remove 
an entry, while the Edit button allows you to make modifications to an entry. 

To enter a single IP address:  

¶ Enter the same IP address into the Starting IP Address and Ending IP 
Address boxes. 

To enter ranges of IP addresses:  

1.  Enter the first IP address in the range into the Starting IP Address box. 

2. Enter the last IP address in the range into the Ending IP Address box. 

If needed, you can add additional IP address or ranges of IP addresses at any 
time by clicking the Add button. 

Note: For more information regarding security features, see ñSecurity Modelò on 
page 215. 

Communicating Using SSL Certificates 

The Communications: SSL dialog box is used to install or select an SSL 
certificate. ipMonitor uses SSL to provide the secure exchange of data across 
non-secure networks, such as the Internet. 

The following methods are supported for acquiring an SSL certificate:  

¶ Generate and install a Self-Signed Certificate. 

¶ Acquire a certificate from a trusted Certificate Authority. 

¶ Request a certificate using the Microsoft Windows 2000 Certificate Services 
Web interface. 

¶ Request a certificate from an enterprise certification authority using the MMC 
Certificates snap-in. 

This section discusses installing a Self-Signed Certificate, which represents the 
easiest installation method with no cost involved. 

Note: The ipMonitor Credentials Manager feature requires that you log in over an 
SSL-secured connection. If you log in through a non-secure channel, the 
Credentials Manager:  
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¶ Permits only limited viewing of credentials  

¶ Prohibits any changes to credential configuration 

Note: For information regarding other methods of installing certificates, see 
ñSSLò on page 219. 

Generating a Self-Signed Certificate 

To create a Self-Signed Certificate: 

1. Access the Communications: SSL window. 

2. Select the Self-Signed option from the SSL Certificate Mode drop-down 
menu 

3. Click the Create New Self-Signed Certificate button. 

4. Enter the fully qualified domain name of your ipMonitor server into the 
Common Name text box. 

After clicking the Create button, information regarding the newly generated Self-
Signed Certificate is displayed, and the certificate is created in the Local Machine 
certificate store. 

Important: Click OK to accept the SSL Certificate. You have to specifically 
accept the Certificate; otherwise it is simply added to the store and not assigned 
to ipMonitor. 

Note: After the SSL certificate has been installed, it is necessary to configure 
ipMonitor to listen for HTTPS traffic. This can be accomplished in the ipMonitor 
Configuration program by changing the "Communications: Web Server Ports" 
options. 

Trusting a Self-Signed Certificate 

The ipMonitor Web Interface Internet shortcut, located on the Windows Start 
menu under the SolarWinds program group, automatically adjusts to use the 
HTTPS protocol when you assign an SSL certificate. 

The first time you log in to the ipMonitor SSL interface, your web browser 
displays a security alert. 

To install a certificate using Internet Explorer 

1. Click View Certificate. 

2. Click Install Certificate button to start the Certificate Import Wizard. This 
creates trust by copying the certificate to the Trusted Root Certification 
Authorities store. 

3. Select the Automatically select the certificate store based on the type of 
certificate option. 
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4. After the certificate is added to the store, the self-signed certificate is trusted. 
You will not receive any further Security Alerts. 

Using a Certificate from the Local Machine Store 

Certificates that are installed in the Local Machine Store can be accessed from 
the Manual Selection (advanced) menu option. 

All Certificates in the Local Machine Store are listed and may be selected for use 
with ipMonitor. 

Service Settings 

The Service Settings window is used to assign a Windows account for the 

ipmonitorsrv  service to run under. 

When choosing an account, you must take into consideration the Credentials 

Manager, a key element of our security model. The ipmon itorsrv  service is 

intended to run under an account with minimum permissions. The Credentials 
Manager impersonates accounts with elevated permissions when required to 
execute monitors, alerts, and features such as the:  

¶ Drive Space monitor. 

¶ File monitor. 

¶ Server/Workstation control. 

¶ Reboot Server action. 

Note: For more information regarding credentials, see ñCredentialsò on page 223. 
For information regarding security, see ñSecurity Modelò on page 215. 

The LocalSystem Account 

The LocalSystem account is the default Windows account assigned to the 
"ipmonitorsrv" Service when the software is installed. 

Although continuing to use the LocalSystem account is an option, it should be 
noted that the privilege level of the LocalSystem account on the local machine is 
greater than the privilege level required by the "ipmonitorsrv" service. 

If you wish to adhere to a stricter security model, we suggest creating a Local 
User account specifically for the "ipmonitorsrv" service to run under, as 
discussed below. 

If assigning either the LocalSystem account or a low privileged Local User 
account, you need to use the Credentials Manager for features that need to 
access Windows file system objects or services via the network. 



 
30 Ö Configuring ipMonitor 

Creating an Account for the "ipmonitorsrv" Service 

Browse Button 

The Browse button can be used to select an account from either the local 
computer account container or from the domain account container. 

Startup Type 

By default, the "ipmonitorsrv" service is set to the Automatic startup type. Under 
normal circumstances, this default should not be changed. The same options you 
can select from the Windows Services manager (Automatic, Manual, and 
Disabled) are available here. 

The following table outlines the minimum permission requirements for any 
Windows Account assigned to the "ipmonitorsrv" service: 

Folder Name Permissions  

\ipMonitor\ READ + WRITE + EXECUTE  

\ipMonitor\config\* READ + WRITE  

\ipMonitor\db\* READ + WRITE if storing Monitor Statistics  

\ipMonitor\historic\* READ + WRITE if storing Monitor Statistics  

\ipMonitor\internal\* READ ONLY  

\ipMonitor\logs\ READ + WRITE  

\ipMonitor\state READ + WRITE  

\ipMonitor\wwwroot\* READ ONLY 

Do I Need to Use the Credentials Manager? 

Although ipMonitor can function without using the Credentials Manager feature, 
we do not recommend it for security reasons. 

If you choose not to use the functionality provided by the Credentials Manager, 
you likely need to assign a Domain Administrator class account to the 
"ipmonitorsrv" service. In the event of a security breach, however, this scenario 
potentially exposes all the resources the high privileged account has access to. 

The Credentials Manager may also be used to impersonate non-Windows 
accounts. For example, an HTML/ASP monitor may need to authenticate to a 
web server challenging with the Digest Authentication scheme. As this example 
illustrates, it is difficult to leverage the full capabilities of ipMonitor without using 
the Credentials Manager. 

Note: ipMonitor uses RSA 512/1024 bit encryption to internally store all sensitive 
parameters and data. 
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Chapter 3 

Dashboard Views 

The Dashboard and Dashboard View consolidate a variety of small reports 
(called web resources) into a summary page that shows status information for 
any device, group or monitor. Each monitor, device, and group has a dashboard 
view that you can customize with different resources to show as much or as little 
information as you want. 

From here you can: 

¶ change the layout of the web resources using drag-and-drop editing 

¶ show the top devices by bandwidth use, ping time, cpu utilization, and other 
criteria 

The dashboard for the My Network group is unique, and does not share its 
dashboard layout with any other group. All other groups, devices, and monitors 
share a common dashboard layout with other dashboards of the same kind.  

Dashboard Layouts are Shared Between Object Types 

ipMonitor displays dashboard information using four different dashboard layouts. 
Each type of layout is shared by all objects of that same type. For example, 
Monitor dashboards all use the same monitor dashboard layout, and so on 

¶ Monitors. Used to display information about monitors. 

¶ Devices. Used to display information about devices. 

¶ Groups. Used to display information about groups, smartgroups, and 
subnets 

¶ My Network. Used to display information about the entire network. This is 
the dashboard information you see when you click the Dashboard tab. 

Changing the Layout of Dashboard Views 

Dashboard templates are shared between types, so making a change to the 
layout of one dashboard type makes the same change to all dashboards of the 
same type. For example, adding a map to the dashboard of a group adds that 
same map to the dashboard of all groups. 
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To change the column layout: 

1. Click Change Columns. The Change Columns dialog box appears. 

2. If you want to insert a column, click the Add Column button in the column 
to the left of the desired column position. 

3. If you want to delete a column, click the Delete Column button in the 
column you want to delete. 

4. If you want to change the width of a column, type a new value in the 
Width textbox of the column whose width you want to change. Width values 
are in pixels. 

5. Click OK. 

To add a new web resource to a layout: 

¶ From the Add Web Resource menu, click the web resource you want to 
add. 

To move web resources within the layout: 

¶ Drag the title text (not the title bar) of any dashboard web resource to the 
desired location. 

Web Resource Types 

You can add many different types of web resources to a dashboard. 

Web Resources for Group Dashboards and the My Network Dashboard 

¶ Map. A specific map, or the default group map. 

¶ My Reports. A list of report templates that apply to this group. 

¶ Getting Started. A list of common tasks to help get you started. 

¶ Device Tree, by properties. A hierarchal device list, organized by properties 
you choose. 

¶ Monitor Tree, by properties. A hierarchal monitor list, organized by 
properties you choose. 

¶ Dependency States. A list of all dependencies for the group and their status. 

¶ Devices with Down Monitors. A list of all devices with monitors in a down 
state. 

¶ Group Contents. A list of all explicitly defined group contents, sorted by 
status. 

¶ Monitor States. A list of all monitors in the group, even those included inside 
other groups or monitors, sorted by status. 
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¶ Summary Counts. A numerical summary of the objects that belong to this 
group 

¶ Tag Details. A list of all tags defined for this group. 

¶ Top XX Devices by Property (availability, bandwidth use, battery, CPU use, 
disk use, humidity, memory, ping, response time, temperature). A list of the 
devices with the most marginal values for the selected property. 

Web Resources for Device Dashboards 

¶ Map. A specific map, or the default group map. 

¶ My Reports. A list of report templates that apply to this group. 

¶ Dependency States. A list of all dependencies for the device and their 
status. 

¶ Device Contents. A list of the monitors that belong to the device, sorted by 
status. 

¶ Device Details. A list of the device properties. 

¶ Monitor States. A list of the monitors that belong to the device and their last 
test results, sorted by status. 

¶ Tag Details. A list of all tags defined for this device. 

¶ CPU Utilization. Gauges showing current CPU utilization for the device. 

¶ Disk Utilization. Gauges showing current disk utilization for the device. 

¶ Memory Utilization. Gauges showing current memory utilization for the 
device. 

Web Resources for Monitor Dashboards 

¶ My Reports. A list of report templates that apply to this monitor. 

¶ Monitor Details. A list of the monitor properties. 

¶ Tag Details. A list of all tags defined for this monitor. 

¶ Performance Chart. Graphs that plot the last 23 hours of statistics for this 
monitor (availability, uptime, downtime, response time, battery capacity, 
SNMP value, SNMP delta value, free drive space, used drive space, free 
memory, used memory, CPU usage, traffic in, traffic out, download speed, 
humidity, temperature, file size, downloaded rows). 

¶ Performance Gauge. Gauges showing current statistics for this monitor 
(availability, response time, used memory, used drive space, CPU usage, 
humidity, battery capacity, temperature, traffic in & out). 
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Chapter 4 

 Managing Devices 

The Devices tab contains views that allow you to classify, organize, and see the 
status of the devices and monitors in your network.  

¶ Details View. The Details View provides a tree view representation of your 
network hierarchy. 

¶ Map View. The Map View provides a graphical representation of your 
network hierarchy.  

¶ Dashboard View. The Dashboard View consolidates a variety of small 
reports into a summary page that shows status information for any device, 
group or monitor.  

¶ NOC View. The Network Operations Center (NOC) view provides at-a-glance 
status reports for IT personnel and network operations groups who manage 
the network around the clock. 

Details View 

The Details View provides a tree view representation of your network. From here, 
you can: 

¶ explore the status of devices and monitors 

¶ organize your devices and monitors into groups, smartgroups, and subnets 

¶ modify device and monitor properties and descriptions either individually or 
as a group 

¶ add custom information tags 

¶ disable or suspend monitors and devices 

Add menu 

¶ Add New Group. Add a new group to the tree. 

¶ Add New Smartgroup. Add a new smartgroup to the tree. 

¶ Add New Subnet. Define a new subnet within the Subnet group. 

¶ Add New Device. Add a new, unscanned device to a group. 

¶ Add Existing Device. Add a previously scanned device to a group. 

¶ Add New Monitor. Add a new monitor to a device. 
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¶ Add Scanned Monitors. Add a previously scanned monitor to a device. 

¶ Add Existing monitors. Add an existing monitor to a group. 

¶ Add Dependency. Create a dependency in a device or group. 

¶ Add Alert. Associate an alert with a group, device, or monitor. 

¶ Add column. Add another column of data to the Details view. 

Discovery menu 

¶ Scan Network. Launch the Device Discovery Wizard to scan for new device. 

¶ Previous Scan Results. Show the results of the last network scan so that 
you can add monitors that you chose to skip after the last scan. 

Clone command 

Make a copy of the selected object or objects. 

Monitors can be cloned to quickly add new monitors to your network. After you 
clone a monitor, simply change only the parameters you need (such as the 
Monitor Name or IP address) to put the new monitor into service. 

Cloned monitors are disabled by default, and have the [cloned] label applied to 
the Monitor Name. 

If you need consistent custom tags in every monitor, cloning allows you to 
duplicate this information instantly. The importance of the tag remains the same 
upon cloning, so you can quickly discern which monitors have important 
information or require further tag configuration. 

Move command 

Move the object to another group. You cannot move monitors out of their parent 
group. 

Edit menu 

¶ Properties. Edit the properties of the selected object. 

¶ Tags. Edit the tags of the selected object. 

¶ Mass Edit Monitor Properties. Perform text substitutions and other large 
scale changes within the property fields of a group of objects. 

¶ Mass Edit Monitor Tags. Perform text substitutions and other large scale 
changes within the tags of a group of objects. 

Enable command 

Resume testing previously disabled monitor selections. 
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Disable command 

Stop testing the selected monitors. 

Suspend menu 

¶ Suspend for xx minutes. Temporarily pause testing of the selected 
monitors for the stated number of minutes. Ideal for periods of unscheduled 
network or server maintenance. 

¶ Suspend for xx hours. Temporarily pause testing of the selected monitors 
for the stated number of hours. 

¶ Unsuspend immediately. Resume testing of the selected monitors. You can 
reset the testing cycle for a monitor by suspending it, and then immediately 
unsuspending it. This can be used to promptly reapply new configuration 
parameters. 

Delete menu 

¶ Delete. Permanently delete the selected object or objects from your network. 
If the selected object is a group, you are asked in a subsequent dialog box 
whether you want to delete only the group, or delete the group and all its 
contents. 

¶ Remove from Group. Removes the selected objects from the current group. 

Creating Groups 

ipMonitor supports the ability organize individual monitors and devices together 
under a group. A group does not contain the actual monitors and devices, but 
merely references them as members. In this way, monitors and devices can 
belong to several different groups. 

You can create dependency relationships between critical resources and the 
entire group. This prevents multiple alerts from being sent when only a single 
alert can suffice. 

To create a group: 

1. Click the Devices tab. 

2. Select a group in the tree where you want to create the new group. 

3. From the Add menu, click Add New Group. 

4. In the Group Name text box, type the name of the group, then click OK. 
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As with monitors, a good naming strategy can greatly improve working with 
groups. For example, you might choose names based on: 

¶ Level of importance 

¶ Purpose 

¶ Location 

¶ Responsibility 

¶ Department 

To add monitors and devices to a group: 

1. Select the group. 

2. From the Add menu, click Add Existing Monitors or Add Existing 
Devices. 

3. Select the check boxes next to the monitors or devices you want to add, then 
click Continue. 

You can add both monitors and devices to the same group. 

Creating SmartGroups 

SmartGroups are dynamic groups whose contents are determined by a filter that 
you create. Unlike regular groups, whose contents never change, the contents of 
a SmartGroup automatically keep track of changes in your network. Some 
examples of SmartGroups include: 

¶ a group of all your network devices located in Texas. 

¶ a group of all the offline monitors in your network. 

¶ a group of all the Cisco devices in your network. 

To create a SmartGroup: 

1. Click the Devices tab. 

2. From the Add menu, select Add New SmartGroup. 

3. Create the filter rules that define the SmartGroup, and then click OK. 

Example of Creating a SmartGroup 

In this example, we create a Smartgroup that contains all our devices 
manufactured by Cisco Systems. 

1. Select the My Network group in the devices tree. 

2. From the Add menu, select Add New SmartGroup. This takes us to the Edit 
SmartGroup page. 
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3. In the Name text box, type All Cisco Devices . 

4. In the SmartGroup Contains box, select Devices. 

5. In the Start With box, select No Devices. 

6. Add a rule that can compare the Device Vendor property of each device. 

a. Click the arrow after ñdevices, whereò, and then select Property from 
the list. 

b. Click Click here to Select a Property to open the property menu. 

c. From the box at the bottom of the menu, select Device Properties. 

d. From the list, click the Device Vendor property, and then click the Close 
button to exit the menu. 

7. Use the regex wizard to create a regular expression for the Matches regular 
expression text box that matches the case-sensitive string ñCiscoò. 

a. Click RegEx Wizard to open the Regex Wizard dialog box. 

b. In the Match begins with text box, type Cisco . 

c. Scroll to the bottom of the dialog box, and then copy the text 

\ iCisco.*?$  that has been created in the Regular Expression you 
have built text box. 

d. Click Close to return to the Edit SmartGroup page. 

e. Paste \ iCisco.*?$ into the Matches regular expression text box. 

8. Click Preview to preview the contents of the new SmartGroup. 

9. Click OK to create the SmartGroup. 

Creating Subnets 

A subnet is an IP address range within your network. In ipMonitor, adding a new 
subnet creates a group that contains references to devices within the subnet. 
ipMonitor creates these references automatically when you create the subnet. 
You do not manually add devices to a subnet. 

To create a subnet: 

1. Click the Devices tab. 

2. Click the Subnets group in the tree. 

3. From the Add menu select Add New Subnet. 

4. Enter the name and IP address range of the subnet, and then click OK. 
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Map View 

A map is a graphical representation of your network devices and monitors. Maps 
allow you to visualize the effects of a failing device or monitor.  

ipMonitor creates default maps for each group and device in your network. These 
maps provide a graphical representation of your network. From the Map view, 
you can: 

¶ change the layout and scale of a map 

¶ add background images and change icons 

¶ connect network items with lines that represent monitor status 

¶ see more details about items on the map by clicking the items 

To view a map of a device or group: 

1. Click the Devices tab. 

2. Select the group or device from the tree. 

3. Click the Map button. 

To resize the map: 

¶ Move the Scale slider to the left to zoom in, and to the right to zoom out. 
-or- 

¶ Click Fit To Screen to automatically size the map to the full extent of the 
area. 

To add a map to the main dashboard: 

1. Click the Dashboard tab. 

2. From the Add Web Resource menu, select Map. This adds a new, default 
map resource to the Dashboard. 

3. From the Edit menu of the new map resource, click Select Map. The Select 
Map dialog box appears. 

4. From the Select map to display list, click the specific device or group map 
that you want to display. 

5. If you want to display the default map, from the Select map to display 
list, click Default Group for Dashboard. 

6. Click Save, and then confirm the change. 

7. The new map replaces the default map in the dashboard. 

Editing Maps 

You can change the layout and scale of any map using the map editor. 
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Basic Map Editing Tasks 

To edit a map: 

1. Click the Devices tab. 

2. In the Details view, click the device or group whose map you want to edit. 

3. Click the Map button. 

4. Click Edit Map. 

To move map objects within the map: 

¶ Select an object, and then drag it to a new location. 
-or- 

¶ From the Auto Layout menu, click a layout type: Circular, Organic, or 
Tiled. 

To add a background to the map: 

1. From the Change Background menu, click Upload Background. 

2. Click Browse, and then select a JPG, PNG, or GIF format image file. 

3. Click Upload. 

To change the icon of a map object: 

1. Click the object. A bounding box appears around it 

2. Click the Icons list, and then select an icon category. 

3. Click an icon. 

4. The object changes to that icon. 

To resize an object: 

1. Click the object. A bounding box appears around it. 

2. Drag any handle on the bounding box to resize. 

To save the changes made to a map: 

¶ Click Save to save the map. 

Connecting Lines and Assigning Monitors 

Between any two objects, we can create logical connections that represent the 
status of a monitor. For example, we can draw a line between two devices and 
assign a bandwidth monitor to that connection. If the monitor goes into a down 
state, it will be reflected in the map. 

To create a connection between two objects. 
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1. From the Drawing Tools palette, click the line drawing tool. 

2. Drag a line from one object to another. 

3. A connection is created between the two objects. 

To assign a monitor to a connection. 

1. From the Drawing Tools palette, click the selection tool. 

2. Click on an existing connection to select it. 

3. Click Assign Monitor. 

4. Select a monitor, and then click OK. 

5. A monitor status indicator appears over the line. 

Note: Within the Map Editor, the monitor status indicators are not active. To see 
the true status of the monitor, you must exit the Map Editor. 

NOC View 

The Network Operations Center (NOC) view provides at a glance status reports 
for IT personnel and network operations groups who manage the network around 
the clock. 

The NOC View uses color codes to prioritize individual Monitors within a Group. 
When ipMonitor detects a problem, the resource color changes from green to 
amber, and may then progress to red and then to dark red as ipMonitor detects 
successive failures. 

As this process occurs, the interface is reflowed to move the failing Monitor(s) to 
the top of the list. At a glance, you will know where to direct your troubleshooting 
efforts even before ipMonitor begins the Alerting process. With web browser 
sounds enabled, you can also be alerted audibly. 
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Chapter 5 

 Viewing Reports 

Reports make it easy to view detailed monitoring data in both graphical and 
tabular formats.  

This section describes these topics: 

¶ My Reports 

¶ Report Templates 

¶ Quick Device and Group Reports 

¶ System Status 

¶ Scheduled Reporting Tasks 

My Reports 

My Reports are configurable reports that make it easy to view detailed monitoring 
data in both graphical and tabular formats. In addition to displaying Response 
Time, Uptime and Downtime for specified time periods, you can leverage 
historical data to view long-term and short-term performance trends, identify 
problems, and report operational efficiency for individual monitors and for monitor 
groups. 

Extensive customization options make it possible to: 

¶ Use the data sources available to display data averages for CPU, Memory, 
Battery, Temperature, Humidity, Hard Drive and Bandwidth Usage Monitors 
in graphical or tabular format. 

¶ Arrange Monitor data for display in line graphs, vertical bar graphs, horizontal 
bar graphs, area graphs, or in tables. 

¶ Display data spanning multiple time periods in one Report. 

¶ Display statistics data for multiple Monitors in one Report, even if the 
Monitors do not belong to the same Group. 

¶ Generate yearly, quarterly, monthly, weekly, daily or hourly Reports, as well 
as Reports for custom time periods, such as business hours for work weeks. 
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To create a configurable Report using the Add Report Wizard 

1. Click the Reports tab. 

2. In the My Reports column, click Add New Report. 

The Add Report Wizard is designed to help you create a Report with the least 
amount of initial input. There are a number of benefits to this approach: 

¶ Configuration is fast and easy, allowing you to create new Reports quickly 
and efficiently. 

¶ The Add Report Wizard allows you to test the selected customization options 
by previewing the appearance of the Report before saving it. 

To edit a configurable report: 

1. Click the Reports tab. 

2. In the My Reports column, pause your mouse pointer over the configurable 
report. 

3. Click the arrow that appears next to the configurable report to open the 
shortcut menu. 

4. Select a command from the shortcut menu: View Report, Edit Properties, 
Edit Tags, Clone, or Delete. 

Report Templates 

After a Configurable Report has been created using the Add Report Wizard, the 
Edit Report page allows you to further customize the Report template to display 
data accumulated over a period of time in a wide variety of formats. The ability to 
create Reports based on reoccurring time selections makes Report Templates 
ideal for creating customized Service Level Agreement (SLA) Reports. 

In addition to displaying Response Time, Uptime and Downtime for specified time 
periods, you can leverage historical data to view long-term and short-term 
performance trends, identify problems, and report operational efficiency for 
individual Monitors and Groups of Monitors. 

Extensive customization options make it possible to: 

¶ Use the data sources available to display data averages for CPU, Memory, 
Battery, Temperature, Humidity, Drive Space and Bandwidth Usage Monitors 
in graphical or tabular format. 

¶ View data averages for CPU, Memory, Battery, Temperature, Humidity, Drive 
Space and Bandwidth Usage Monitors using resource icons, which provide a 
visual representation of the information. 
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¶ Arrange Monitor data for display in line graphs, horizontal bar graphs, vertical 
bar graphs, area graphs, or in tables. 

¶ Display data spanning multiple time periods in one Report. 

¶ Display statistics data for multiple Monitors from multiple Groups in a single 
Report. 

¶ Generate yearly, quarterly, monthly, weekly, daily or hourly Reports, as well 
as Reports for custom time periods. 

¶ Create numerous presentation-quality Report styles by fully controlling the 
design and layout of each Report. 

¶ Add custom logos or other graphics, and use CSS and HTML code to further 
customize the appearance of each Report. 

¶ Add custom headers and footers to each Report. 

¶ Assign permission levels to determine which Administrator or User Accounts 
can view a particular Report. 

To access report templates for a previously configured report 

1. Log in to the ipMonitor web interface. 

2. Click the Report tab, then click Manage all reports. 

3. Click a previously configured Report to launch the Edit Report page. 

Quick Device and Group Reports 

Device Reports and Group Reports make it easy to view specific monitoring data 
for a group or a device.  

To view a Device Report or Group Report: 

1. Click the Reports tab. 

2. Click a report type from the Device Reports or Group Reports column. 

3. Select the group or device you want to view, and then click Continue. 

Note: You will see a blank report if you select a report type that does not exist for 
your selection. For example, you will see a blank report if you try to view the CPU 
Utilization report for a device that does not have a CPU monitor. 

You cannot edit the report parameters of a device or a group reports, but you can 
save an editable copy to your My Reports. After saving a quick report to My 
Reports, you can edit and tweak it as you would any other Customizable Report. 
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To save an editable version of a Quick Report 

¶ When viewing a Quick Report, click Save to My Reports. 

System Status 

The System Status report allows you to view details about the server that 
ipMonitor is installed on, as well as the ipMonitor installation itself.  

In the event that you need to contact ipMonitor technical support, details such as 
the ipMonitor version and build number, free hard disk space, physical memory 
available on the server and other relevant information found here can be 
particularly useful for troubleshooting purposes. 

Monitoring Services Information 

¶ Version. The ipMonitor Major Version and Build number. 

¶ Uptime. The total running time of the ipMonitor 8 Service. 

¶ CPU Utilization. The total processor time used by the ipMonitor Service 
since it was started. 

¶ License.The number of Monitors available on the installation and the number 
of Monitors configured. 

¶ Support Policy.The Support Policy ID associated with your installation. 

Reporting Services Information 

¶ Version. The ipMonitor Major Version and Build number. 

¶ Connected. The current connection state of the ipMonitor Report Service. 

¶ Uptime. The total running time of the ipMonitor Report Service. 

¶ CPU Utilization. The total processor time used by the ipMonitor Report 
Service since it was started. 

¶ Last Report. The date and time the last Report was generated by the 
ipMonitor Report Service. 

¶ Time Taken. The length of time it took the ipMonitor Report Service to 
generate the Report. 

¶ Records Seen. The number of data records gathered during the process of 
creating the last Report.  

System Information 

¶ OS. The current Operating System and Service Pack level. 

¶ OS Version. The numeric operating system version and build number. 

¶ Processor Type. A description of the ipMonitor server processor. 
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¶ Processor Speed. The processor speed, in MHz or GHz. 

¶ Processors Active. The number of processors detected on the ipMonitor 
server. 

¶ MDAC. The version number of Microsoft Data Access Components currently 
installed on the system. 

System Vitals 

¶ Physical Memory. The amount of Physical Memory on the ipMonitor server, 
shown in megabytes (MB) and/or gigabytes (GB). Gray bars indicate 
available memory, while green bars indicate allocated physical memory on 
the server. When available memory reaches 10% or less, the color of the 
available memory area changes from green to red. 

¶ Commit Charge Memory. The amount of Virtual Memory on the ipMonitor 
server, shown in megabytes (MB) and/or gigabytes (GB). Gray bars indicate 
available memory, while green bars indicate allocated physical memory on 
the server. When available memory reaches 10% or less, the color of the 
available memory area changes from green to red. 

¶ Drive x. The amount of Drive Space on the hard drive / partitions located on 
the ipMonitor server, shown in megabytes (MB) and/or gigabytes (GB). The 
gray area indicates available drive space, while the green area indicates 
allocated drive space. If the remaining available drive space is dangerously 
low, the color of the used Drive Space area changes from green to red. 

Scheduled Reporting Tasks 

Scheduled Reporting Tasks allow you to: 

¶ Email your Configurable Reports and Quick Reports to a predefined list of 
recipients at scheduled intervals. 

¶ Save your Configurable Reports and Quick Reports to disk. 

In addition to displaying Response Time, Uptime and Downtime for specified time 
periods, you can leverage historical data to view long-term and short-term 
performance trends, identify problems, and report operational efficiency for 
individual Monitors and Groups of Monitors. 

Report Publisher features include: 

¶ The ability to email Reports on a daily or weekly basis. 

¶ The ability to email Reports to multiple recipients. 

¶ Control over the format of the images included in the Report. 

¶ Full control over the file name of the Report saved to disk. 
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¶ The ability to specify the directory where the Report will be saved. 

Email Report Publishers 

Email Report Publishers make it easy to schedule your Reports to be emailed to 
a list of recipients at regular intervals. 

To configure an Email Report Publisher: 

1. Log in to the ipMonitor web interface. 

2. Click the Configuration tab, and then click Scheduled Reporting Tasks. 

3. Click the Add Email Report Publisher button. 

Disk Report Publishers 

Disk Report Publishers allow you to save your reports to the location of your 
choice. 

To configure a Disk Report Publisher: 

1. Log in to the ipMonitor web interface. 

2. Click the Configuration tab, and then click Scheduled Reporting Tasks. 

3. Click the Add Disk Report Publisher button. 

 

Report for Business Hours 

 

A common scenario is to have a report that is scheduled to reflect business hour. 

To accomplish this you must first create a report using the Add New Report 
Wizard.   

Add the Monitors you need.  

Once the report is created, you need to add 5 time selections: 

¶ Start At this week.  Go forward 1 day and 9 hours.  Include 8 hours.  
(This will give you Monday 9-5)  

¶ Start At this week.  Go forward 2 days and 9 hours.  Include 8 hours.  
(This will give you Tuesday 9-5)  

¶ Start At this week.  Go forward 3 days and 9 hours.  Include 8 hours.  
(This will give you Wednesday 9-5)  

Once the 5 Time selections are created, you then need to add Report Elements 
(Graphs, Tables, etc.) for each time selection. 
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Chapter 6 

Configuration 

The configuration page provides access to all the items and settings in ipMonitor 
that can be configured. This includes alerts, user accounts, credentials, and 
scheduled reports. It also contains tools to help you administrate your network. 

Settings 

If you want toé Then selecté 

Change user access permissions Account List 

Create a schedule for generating reports Scheduled Reporting Tasks 

Create or modify alerts Alert List 

Create or modify ipMonitor accounts and 
passwords 

Account List 

Disable monitors during scheduled 
maintenance 

Scheduled Maintenance Tasks 

Import and export XML ipMonitor data System Settings 

Log ipMonitor activity System Settings 

Manage credentials Credential List 

Manage the settings of the ipMonitor server System Settings 

Manage the settings of your account My Settings 

 

Tools 

If you want toé Then selecté 

Add a new device to ipMonitor Add New Device 

Browse the MIB database SNMP Tree 

Share notes with other ipMonitor users Notes 

Create regular expressions Regex Wizard 

Monitor the status of an SNMP object SNMP Monitor Wizard 

Reboot a windows server or workstation Server/Workstation Control 

Search for an entry in the MIB database SNMP Search 

Stop or restart a remote windows service Server/Workstation Control 

Update ipMonitor to the latest version Updates 

View all the devices discovered by ipMonitor Scan Results 

View the log files Log Files 

View who is currently logged into ipMonitor Sessions 
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Updates 

The Updates command allows you to query the ipMonitor update service 
regarding the latest Upgrades, Updates and Fixes available under the Service 
Plan. 

Click the Scan for Updates button to begin the query process. 

Protocol 

Choose between the HTTPS / SOAP and HTTP / SOAP protocols. Outbound 
HTTP or HTTPS access is required to check for updates. 

Site 

The update service engine connects to ipmsupport.solarwinds.com. This location 
does not require authentication.  

Force communication through a Proxy Server 

Select this option if your organization connects to the Internet through a proxy 
server. 

Any new updates that have been released but not applied to the current 
ipMonitor will be listed when you click Continue. Information includes:  

¶ Importance level.  

¶ Date of release.  

¶ Build Number.  

¶ List of fixes and enhancements.  

¶ Link to download the Upgrade, Update or Fix.  

Before you select this option, ensure that you have correctly set up the Client 
HTTP Settings to permit communications with your proxy server. You can 
access the Server Settings from the Configuration tab. 

Note: This feature does not run automatically; it can only be initiated by clicking 
the Scan for Updates button. 

Sessions 

The Sessions tab allows you to view Administrators and Users currently logged 
in to your ipMonitor installation. 

Last Access 

The last time the Administrator or User accessed the installation. 

Session Age 
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The length of time that has passed since the Administrator or User logged in. 

Guest? 

This column indicates whether the account is a Guest Account. 

Notes 

The Notes feature is ideal for IT departments that have a team of people 
accessing and using the Administration interface at various times.  

Notes can be used to post messages for other ipMonitor Administrators and 
Users, such as: configuration settings, policy information, problem resolution, tips 
and tricks, and so on.  

Using Notes to Share Information 

If you plan to use Notes to share information with your team, each Administrator 
and User Account should:  

1. On the Configuration page, click My Settings. 

2. From the Start Page list, select Notes.  

The Notes page will then be the first page Administrators and Users see after 
logging in. Like a message board, new messages will be located at the top of the 
page.  

Deleting Messages 

To delete a message, check the box adjacent to the message, and then click the 
Delete button. 

To delete all messages, check the box adjacent to the Delete button, and then 
click Delete. 

Note: Administrators can delete any message that is posted. Users are only able 
to delete messages that they post. Check boxes are only displayed for messages 
posted by that User.  

Adding Messages 

To add a new message, click the Add Note button. 

Adding Format Styles to Messages 

Messages can be posted in plain text, or Tags can be used to format text. 
Formatting requires an opening tag and a closing tag. For example, to write Bold 
Text, you would type: [B]Bold Text[/B]. 
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Tags can be inserted using the various format options shown below. 
Alternatively, you can type opening and closing tags directly into the message. 

Tag Function 

[B] [/B] Insert bold font. 

[I] [/I] Insert Italic font. 

[U] [/U] Underline font. 

[S] [/S] Strike through a word or a line of text. 

[CENTER] 
[/CENTER] 

Center text or an image. 

[CODE] 
[/CENTER] 

Set a fixed width font. 

[URL] [/URL] Insert an active URL link. 

[FONT] [/FONT] Set the size, style and color of your preferred font. 

[EMAIL] [/EMAIL] Insert an active email address link. 

[IMAGE] [/IMAGE] 
Insert an image into your message. Type the URL to the location of the 
image within the tags. 

 

Click the Preview button to view the way your message will appear after it has 
been properly formatted. 

Note: Administrators have full control over whether Users can view and / or post 
messages. The Security / Accounts menu is used to configure Notes 
Permissions for User Accounts.  

thwack Resource 

 ipMonitor thwack tab  

¶ Provides quick access to the most recent thwack community forum posts and 
file uploads for ipMonitor. Search for ipMonitor related content directly from 
the web interface.  
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Chapter 7 

Relations 

The Relations page offers a top-down look at the way the essential elements of 
your network interrelate with one another, making it easy to spot associations.  

Understanding the relationships between your monitors, groups, and 
dependencies is a key factor in properly configuring an ipMonitor installation. 
Likewise, the relationship between monitors, alerts, and actions is critical to 
ensuring the right people are notified when a problem is detected. Without these 
components working together, actions may not be triggered, or they may not 
reach the intended destination. 

Using the Relations pop-up page, you can display any of the following individual 
configuration components and their associations: 

¶ Monitors  

¶ Groups  

¶ Alerts 

¶ Actions 

¶ Configurable Reports  

¶ Report Publishers  

¶ Maintenance Schedules  

¶ Credentials 

Accessing the Relations Pop-Up Window 

The Relations pop-up window is accessible from the Edit page of any individual 
configuration element listed above. 

For example, you may wish to view all ipMonitor configuration components 
associated with a particular Monitor using the following procedure: 

1. Click the Monitors menu option.  

2. Click on the name of the desired Monitor to enter Edit mode.  

3. From the submenu bar, click the Relations icon. 
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Navigating the Relations Pop-Up Window 

¶ Links. Each configuration element listed in the Relations pop-up window is 
linked to its own Relations page. For example, the Relations pop-up window 
for a particular Monitor may display Groups, Dependencies, Alerts, Actions, 
Configurable Reports and Report Publishers. Clicking on the name of any of 
these individual elements will automatically direct you to the Relations page 
corresponding to that component. 

¶ Previous Relations. The Previous Relations drop-down selector allows you 
to return to the Relations page of any individual configuration element 
already accessed. A maximum of ten previously accessed configuration 
elements are retained for selection, allowing you to quickly navigate to a 
particular Relations page at any time. 

¶ Edit. To make configuration changes to the settings of any individual 
component displayed in the Relations pop-up window, click the Edit button 
adjacent to the desired element to access it in Edit mode. 
 
For example, you may choose to change the time intervals associated with 
an enabled Alert related to a specific Monitor. To do so, you can simply click 
the Edit button, make the required changes, and then click OK. After the 
configuration changes are complete, you can click the Relations button 
located on the submenu bar to open the Relations pop-up window for the 
alert, and then display any other features that will be affected by the timing 
change. 

Relationship Types 

Individual ipMonitor features can be associated with other essential configuration 
elements. The types of relations displayed in the Relations pop-up window 
depend on the feature being edited.  

Monitors 

A Monitor is a background process that continuously tests a target resource on 
timed intervals. ipMonitor includes a comprehensive suite of Monitors that are 
used to watch system resources, applications, infrastructure equipment, servers 
and essential services around-the-clock. 

Monitor Relations can include: 

¶ Any Dependency Monitor that affects whether or not Alerts will be triggered 
for this Monitor when a problem is detected.  

¶ Any Group that contains the Monitor as a Member.  

¶ Any Group that contains the Monitor as a Dependency.  

¶ Any Alert to which the Monitor belongs.  
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¶ Any Action that is part of an Alert to which the Monitor belongs.  

¶ Any Maintenance Schedule that regulates scheduled downtime for the 
Monitor.  

¶ Any Configurable Report customized to include statistics data gathered by 
the Monitor.  

¶ Any Report Publisher containing a Configurable Report customized to 
include statistics data for the monitor.  

¶ Any Credential assigned to the Monitor.  

Groups 

ipMonitor supports the ability to group together multiple individual Monitors for 
the purposes of assigning them Dependencies. Properly configured Groups and 
Dependencies act as an Alert suppression system in ipMonitor. When a critical 
resource fails, ipMonitor limits Alerts to the Monitors defined as a Dependency 
rather than triggering Alerts for every member Monitor in the Group. 

Group Relations can include: 

¶ Any Monitor designated as a Dependency of the Group.  

¶ Any Monitor designated as a Member of the Group.  

¶ Any Alert to which the Group belongs.  

¶ Any Action that is part of an Alert to which the Group belongs.  

¶ Any Maintenance Schedule that regulates scheduled downtime for the 
Group.  

¶ Any Configurable Report customized to include statistics data gathered by 
the Group.  

¶ Any Report Publisher containing a Configurable Report customized to 
include statistics data for the group.  

Alerts 

An Alert is a collection of actions. Each alert can act on behalf of a set of 
Monitors. Alerts determine what Monitors specific Administrators and 
departments watch, as well as when and how they are alerted. 

Alert Relations can include: 

¶ Any Monitor assigned to the Alert.  

¶ Any Group as ed to the Alert.  

¶ Any Actions belonging to the Alert.  
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Actions 

The comprehensive suite of Actions provides various notification methods, 
integration options, and recovery actions. 

Alert Relations can include: 

¶ Any Monitor associated with the Alert to which the Action belongs.  

¶ Any Group associated with the Alert to which the Action belongs.  

¶ Any Credential assigned to the Alert.  

¶ The Alert to which the Action belongs.  

Configurable Reports 

Configurable Reports make it easy to view detailed monitoring data in both 
graphical and tabular formats. In addition to displaying Response Time, Uptime 
and Downtime for specified time periods, the ability to leverage historical data 
allows you to view long-term and short-term performance trends, identify 
problems and report operational efficiency for individual Monitors and Groups of 
Monitors. 

Configurable Report Relations can include: 

¶ Any Monitor included in the Configurable Report.  

¶ Any Group included in the Configurable Report.  

¶ Any Report Publisher that contains the Configurable Report.  

Report Publishers 

Report Publishers allow you to save Configurable Reports to disk or email them 
to a predefined list of recipients at scheduled intervals. 

Report Publishers can include: 

Any Configurable Report included in the Report Publisher.  

Maintenance Schedules 

Maintenance Schedules allow Administrators to temporarily disable monitoring of 
certain resources, for example to perform data back-ups or Service restart 
actions. 
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Maintenance Schedule Relations can include: 

¶ Any Monitor affected by the Maintenance Schedule.  

¶ Any Group affected by the Maintenance Schedule.  

¶ Any Credential assigned to the Maintenance Schedule.  

Credentials 

In order for ipMonitor to be fully functional, various Monitors, Alerts and 
management features require access to Windows file system objects or Services 
via the network. Instead of running the ipMonitor Service under an Administrator 
account at all times, Credentials are used to apply elevated permissions only 
when required. 

Credential Relations can include: 

¶ Any Monitor that uses the Credential for monitoring purposes.  

¶ Any Recovery Action that uses the Credential for recovery purposes.  

¶ Any Alert that uses the Credential for alerting purposes.  

¶ Any Maintenance Schedule that uses the Credential to perform routine 
actions.  

¶ The Manual Backup action to which this Credential is assigned.  

¶ The Recurring Internal Maintenance Backup action to which this Credential is 
assigned. 
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Chapter 8 

Monitors 

ipMonitor includes a comprehensive suite of Monitors that are used to watch 
system resources, applications, infrastructure equipment, servers and essential 
services around-the-clock: 

¶ Quality Assurance Monitors perform result analysis testing for critical 
applications such as SQL servers, commerce solutions and dynamic web 
applications.  

¶ SNMP polling and Trap Monitors provide industry standard methods for 
monitoring devices such as routers, switches and load balancers.  

¶ Windows NT/2000/XP/2003/2008 Monitors test key aspects of Windows 
operating systems.  

¶ Resource Monitors test finite system resources and alert before consumption 
becomes critical.  

¶ Uptime Monitors test availability of popular TCP/IP protocol based 
application-layer protocols such as HTTP, HTTPS, SNMP, and so on. 

DNS Names Require Lookup Time 

As a general rule, conservative use of DNS names is recommended for TCP/IP 
based Monitors. Service level responsiveness can be timed more accurately by 
removing the DNS lookup from the equation. Monitor response must be 
completed within a specified number of seconds. This includes the time taken to 
perform a DNS lookup. 

Some exceptions apply for Monitors that require access to the Windows files 
system, and HTTP-based Monitors. These are noted in the Help pages for 
individual Monitors. 

If your network uses a DHCP (Dynamic Host Configuration Protocol) server to 
dynamically assign IP addresses, type an IP address only if it is "reserved", 
otherwise type a Domain Name. If a Monitor is configured to use an IP address, 
and that IP address was to be dynamically assigned to another resource, the 
Monitor would no longer be able to successfully monitor the target resource. 

If you assign a DNS Name to a Monitor, timing parameters may be affected by 
the additional time required to perform the DNS lookup. Although the default 
timing parameters for testing should allow for the time it takes to perform the 
DNS lookup, timing is a variable you need to consider when aggressive testing 
times are used. 
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Dependencies 

In cases where many monitored resources depend on one or more critical 
resources to function, Groups can be created and assigned Monitor 
Dependencies. This effectively prevents redundant Alerts from triggering for each 
Member Monitor in the Group when only a single Alert for a Dependency Monitor 
would suffice. 

Maintenance Schedules 

Maintenance Schedules allow you to temporarily suspend monitoring for 
individual Monitors or Groups of Monitors during planned maintenance periods. 

Mass Edits 

When ipMonitor installations range into hundreds or thousands of Monitors, 
manually changing common configuration settings can be time consuming. The 
Mass Edit feature makes it easy to quickly apply large-scale changes to 
configuration fields across any number of Monitors using a rule-based system. 

How It Works: Monitors 

A Monitor is a background process that continuously tests a target resource on 
timed intervals. Testing methods depend on the capabilities of the Monitor, and 
the Test Parameters you specify during Monitor configuration. 

Flexible timing parameters provide the ability to intensify or lessen testing during 
each of the four operational states of a monitor. Each time a Monitor test fails, 
the sequential failure count is incremented and checked against the configured 
Number of failures allowed before Alerting takes place. A successful test at any 
point resets the sequential failure count to zero. 

When a Monitor reaches its maximum number of test failures, it will trigger an 
Alert causing the following series of events to take place:  

1. Each alert is scanned to see if the monitor belongs to it.  

2. If so, action parameters and action schedules are checked for actions within 
the alert.  

3. Any active actions are carried out. 
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Monitor States 

Monitors have five operational states, as well as a disabled state. 

Icon Monitor State Description  

 
Green 

Up and Listening 
The device is responding as expected or ipMonitor 
is listening for inbound SNMP Traps. 

 
Amber 

Warn 
Indicates an unexpected result. Testing is in 
progress, but no alerts have been triggered. 

 
Light Red 

Down 
Alerts are being sent. A Monitor will progress from 
a Fail state to a Lost state when the maximum 
number of Alerts has been processed. 

 
Dark Red 

Lost 
The monitored resource continues to be in an error 
state. All configured alerts have been sent. 

 
Light Gray 

Suspended or in 
Maintenance 

The Monitor is disabled or in Maintenance mode. 

 
Dark Gray 

Uninitialized 
The monitor has not yet been initialized. No testing 
has occurred. 

 

You can view the State of a Monitor using any of the following options:  

¶ Access Live Reports within the Admin Dashboard. Monitors are sorted and 
color-coded based on their State.  

¶ Access the Monitors List within the Configuration interface by clicking the 
Monitors menu option. The Monitor State is displayed under the Status 
heading.  

¶ Access the Edit Monitor page by clicking on the Monitor Name from the 
Monitors List. The Monitor Status is displayed at the top of the page. 

Scanning the Network 

ipMonitor includes a Device Discovery Wizard that seeks out devices on your 
network and recommends resources to monitor. 

Potential Monitors that can be added are based on the types of resources 
detected. Although recommended Monitors can be summarily added to an 
installation, further customizations can also be made by using the Add Device 
Wizard directly from within the Device Discovery feature. 

To start the Device Discovery Wizard: 

1. Click the Devices tab. 

2. From the Discovery menu, click Scan Network. 
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The Device Discovery Wizard makes it easy to: 

¶ Quickly add all recommended Monitors to your installation.  

¶ Pick and choose individual Monitors to add to your installation.  

¶ Add entire Groups of Monitors to your installation.  

Features include: 

¶ Control over the discovery methods ipMonitor uses to perform the Network 
Scan.  

¶ Control over the range of IP addresses that will be scanned.  

¶ The ability to add non-standard ports to the list of ports that ipMonitor will 
probe.  

¶ The ability to navigate through the list of returned items using the tree-like 
structure of the Add Device Wizard that provides a visual representation of 
the device.  

¶ The ability to use cached scan results to add Monitors and Groups to your 
installation over a period of time.  

¶ The ability to exclude servers, workstations and devices from the list of 
resources that will be scanned when the Network Scan Wizard recommends 
Monitors to add to your installation. 

Device Discovery Wizard 

¶ IP Range. Scans IP address ranges for devices 

¶ Network Neighborhood. Scans the Active Directory for devices. 

¶ DNS Zone. Initiates a DNS zone transfer from a DNS server and scans the 
list for devices. 

¶ Host File Import. Scans a list of IP addresses for devices. 

Monitors List 

The Monitors List displays every Monitor configured for your ipMonitor installation 
is displayed in this one list no matter what other groups individual Monitors have 
been assigned to. 

To help you manage the large number of Monitors with relative ease, the 
Monitors List comes equipped with broad search capabilities and various 
management features: 
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¶ Sort the lists by name, status, or type 

¶ Filter the list by name, address, tag, ID, type, or status.. 

The Monitors List shows all configured Monitors by Name, State and Type. 

Controlling List Size 

Use the Items per page drop down menu to control the number of Monitors 
displayed per page. The default is 25 monitors per page. 

Filtering the List 

Use the Filter Text drop down menu to apply a Filter to the Monitors list. 

General Monitor Settings 

All Monitor types available in ipMonitor have the following configuration options in 
common: 

¶ Monitor Submenu 

¶ Monitor Status 

¶ Identification 

¶ Timing 

¶ Notification Control 

¶ Recovery Parameters 

These common options are discussed in this single location to avoid repeating 
the same information throughout each Monitor Type document. 

The Test Parameters and Analysis of Test Results sections are detailed on a 
per-Monitor basis throughout the documentation available in the Monitor Types 
section. 

Note: Monitors can be disabled during scheduled maintenance periods. This 
ability is controlled by the Maintenance Schedules. 

Monitor Submenu 

The Monitor Submenu located at the top of each Edit Monitor page makes it easy 
to perform maintenance actions, configure a Downtime Simulator, view a Report, 
access the Relations page, or pop up a new window to display the configuration 
settings of the monitor in XML format. 

Cancel / Back 

Return to the Monitors List. 
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Disable 

Instruct ipMonitor to stop testing the target resource indefinitely. A confirmation 
prompt will be displayed before Monitors are disabled. 

Delete 

Permanently remove a Monitor from the ipMonitor system. A confirmation prompt 
will be displayed before Monitors are deleted. 

Suspend 

Temporarily pause testing. This ability is ideal for periods of unscheduled 
network or server maintenance. Type an integer value to suspend monitors for 
"x" number of minutes or hours. Fractional and decimal values are not allowed. 

Force Test 

Reset the testing cycle for a Monitor. This option allows you to promptly reapply 
new configuration parameters. 

Clone 

Duplicate the current Monitor. After a Monitor is cloned, simply change only the 
parameters you need, such as the Monitor Name or IP address, to put the new 
Monitor into service. 

Cloned Monitors appear in the Monitors List. They are disabled by default and 
have the "[cloned]" label applied to the Monitor Name. 

Downtime Simulator 

Perform pre-rollout testing for a Monitor. The Downtime Simulator demonstrates 
the Alerting process for a Monitor by illustrating Alert coverage at a specific time 
of day, for any day of the week. 

View Report 

Access Quick Reports for an individual Monitor. Quick Reports are ideal for 
troubleshooting problems as they happen and for identifying short-term and long-
term performance trends at a glance. 

Relations 

Display the associations to other ipMonitor components, such as Groups, Alerts, 
Actions, Maintenance Schedules, Configurable Reports, Report Publishers and 
Credentials. 

Popup XML 

Display the current configuration settings for the monitor in an XML format within 
a new browser window. The XML template can be saved as a .txt file. 



ipMonitor Ö Administration Guide 
 

 
MonitorsÖ 67 

Monitor Status 

The Monitor Status section shows the current operational state of the Monitor. 
The data displayed is based on the Status settings configured in the NOC View 
section of the Real Time Status Reports. 

Status 

The result of the last test performed by the Monitor. Different Monitor types 
generate specific Test Results and Error Codes in accordance with the 
technical capabilities for the Monitor. Please refer to the specific Monitor 
section for a detailed explanation of the Test Results and Error Codes 
reported. 

Availability 

The percentage of time the Monitor has been available. This calculation is 
based on Coverage time. 

Coverage 

The total length of time ipMonitor has been monitoring the resource. 
Coverage specifically excludes any period while the Monitor is suspended, 
disabled, or in maintenance mode. This value is reset when ipMonitor is 
restarted. 

State Change 

The length of time since the Monitor changed operational states. This 
includes time elapsed since scheduled maintenance. 

Example of Availability, Coverage, and State Change 

The following diagram illustrates how ipMonitor calculates Availability, Coverage, 
and State Change. 

 



 
68 Ö Monitors 

Assuming that it is now 12:00 PM and the Monitor was first enabled at 12:00 AM, 
the above diagram tells us that: 

¶ The Monitor has been enabled for 12 hours. During that time, it was not 
suspended or placed in maintenance. This total is recorded in the Coverage 
column. 

¶ During the time the Monitor was enabled, it was in a Warn state for 
approximately 35 minutes, Down for approximately 2 hours and Lost for 
approximately 25 minutes. When totaled, these periods amount to 25% (3 
hours) of the entire Coverage time recorded (12 hours). The Availability 
column, then, shows that the Monitor was available for 75% of the time. 

¶ The Monitor recovered at 6:00 o'clock, exactly 6 hours ago. Since that was 
the last time ipMonitor recorded any change in the monitor status, this length 
of time is appropriately recorded in the State Change column. 

Note: You can choose which Monitor details to display by accessing the NOC 
View page from the Real-Time Status Reports interface. Click the top bar of the 
NOC View page to bring up the configuration menu, and select the desired data 
to display. Refresh the Edit Monitor page to view the newly selected status 
details. 

Identification 

The Identification section defines the Monitor name, enables testing and instructs 
ipMonitor to store statistics. 

Monitor Name 
The Monitor Name is displayed in the Monitors List, the Monitor Status, and the 
Logs pages. 

Names may not be greater than 64 characters. 

Since ipMonitor does not use the name field to identify the Monitor internally, 
Monitor Names can be changed at any time without data loss. 

Add to Group 
Individual Monitors can be added directly to a Group during the Monitor creation 
stage. Simply select the name of the Group to which the Monitor will be added 
from the drop-down box. 

Enabled 
When a Monitor is enabled, it actively tests the specified resource using the 
settings entered in the Test Parameters section. 

To enable a disabled Monitor, check the Enabled checkbox and then click the OK 
or Apply button located at the bottom of the page. 

Alternatively, you can also click the Enable option located on the Edit Monitor 
submenu. 
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Store Monitor Statistics for Recent Activity and Historical Reports 
If selected, ipMonitor will record test results which are then used to generate 
Recent Activity and Historical Reports. 

Timing 

ipMonitor's flexible timing parameters provide the ability to intensify or lessen 
testing during each of a Monitor's four testing states; Up, Warn, Down and Lost. 

For example, you might intensify testing when a Monitor enters a Warn state and 
reduce testing when a Monitor enters a Lost state. 

Maximum Test Duration 
The mechanism used to time out a Monitor test. If a response is not returned 
within the defined number of seconds, the test fails. 

Delays Between Tests While: Up 
The number of seconds between each Test while the Monitor is in an Up (or OK) 
state. 

Delays Between Tests While: Warn  
The number of seconds between each Test while the Monitor is in a Warn state 
(a problem has been detected). Alerts are not processed during the Warn state. 

Delays Between Tests While: Down  
The number of seconds between each Test while the Monitor is in a Down state 
(a failure has been confirmed). Alerts are processed during the Down state. 

Delays Between Tests While: Lost 
The number of seconds between each Test while the Monitor is in a Lost state 
(the resource continues to be down and the maximum number of Alerts have 
been processed). No further Alerts will be processed until the Monitor recovers. 

Notification Control 

The Notification Control section determines how many test failures must occur 
before an Alert is sent, as well as the maximum number of Alerts that will be 
sent. 

Accumulated Failures per Alert 
Each time a Monitor test fails during a Warn state, the sequential failure count is 
incremented and checked against the Accumulated Failures per Alert that must 
occur before Alerting can take place.  

A successful test at any point resets the accumulated failure count to zero. 
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Maximum Alerts to Send 
The number of Alerts to process during a Down state before changing the 
Monitor state to Lost. 

A successful test by the Monitor at any point while in the Down or Lost state will 
cause the Alert sequence to be reset. It is good practice to enable Send 
Recovery Notifications within Alerts to notify you in the event the Monitor 
recovers. 

Recovery Parameters 

ipMonitor can take corrective action to automatically restore a failed resource 
using the:  

¶ External Process Recovery Alert  

¶ Reboot Server Recovery Alert  

¶ Restart Service Recovery Alert  

Although Recovery Alerts are responsible for executing the corrective procedure, 
Recovery Parameters must be defined within the Monitor that triggers the Alert. 
Benefits gained from this system are:  

¶ Maximum Recovery coverage is possible because a "one to one" relationship 
exists between each Monitor and the Resource it is testing.  

¶ A single Recovery alert can service many individual Monitors because 
Recovery Parameters are passed to the Recovery Alert by the Monitor. 

FQDN/NetBIOS/IP Address 
Enter the Fully Qualified Domain Name, NetBIOS Name or IP Address of:  

¶ The computer that will be rebooted by the Reboot Server Alert  

¶ The computer hosting the Windows Service(s) that will be restarted  

Click the Browse... button to:  

¶ Display a list of machines found on the network  

¶ Select a machine to populate this field  

Note: The Reboot Server and Restart Service Alerts require this field. 

Credential for Recovery 
This parameter allows a specific Credential to be used when executing Recovery 
Alerts that require access to restricted resources such as Windows Services. 

Click the Select... button to:  

¶ Pop up the Credentials dialog  

¶ Select an existing Credential from the appropriate category  
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Click New Credential to start the new Credential wizard  

Note: The Reboot Server Alert, Restart Service Alert and External Process Alert 
require that you select a Credential. If a Credential has not been assigned, 
ipMonitor will use the Windows account assigned to the ipMonitor Service. In this 
scenario, results will depend on the level of access the ipMonitor Service account 
has to resources via the network. 

Note: For detailed information regarding Credentials, refer to the section titled 
About Credentials. 

Windows NT Services List 
This parameter is used to define the List of Windows Services to restart. 

Click Select to:  

Begin scanning the machine specified by the FQDN / NetBIOS / IP Address 
parameter  

Select the Service(s) to restart from the list of Services on the machine  

Note: If a Service has Dependencies, you must select ALL dependent Services.  

Note: The Restart Service Alert requires this parameter. 

 

 

 

Downtime Simulator 

The Downtime Simulator is used to perform pre-rollout testing for a Monitor. The 
Downtime Simulator: 

¶ Demonstrates the alerting process for a monitor 

¶ Illustrates the alert coverage of a monitor at a specific time of the day, for any 
day of the week 

The Downtime Simulator runs a synthetic failure by: 

1. Applying the configuration parameters of the monitor. 

2. Scanning each alert to find any associations with the monitor. 

3. Checking Range parameters and Schedules for actions within the alert. 

4. Carrying out any active actions. 

http://support.ipmonitor.com/helps/ee85113b7f3a4079ba1b1a0533d44ffb.aspx
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Configuring the Downtime Simulator 

Enter Edit mode for the specific Monitor you want to test, then click the 
Downtime Simulator button located on the submenu bar. 

Downtime Duration 

Enter the number of downtime minutes to simulate. Be sure to allow enough time 
for the Monitor simulation to progress through to its Lost state (dark red). 

Downtime Start Time 

Enter the day and start time to test Alert coverage for the Monitor. 

Average Test Duration 

Enter the time to allot for each test in the simulation. This is shown in the Time 
column. 

If you make any changes to the Simulation Settings, click the Update button to 
refresh the Simulation Results. 

How it Works: Downtime Simulator 

The Downtime Simulator is easy to understand if you know how the Timing and 
Notification Control parameters are used to control the failure and alerting 
process for each monitor. 

You may want to review the Alerting Process topic, which displays a sample test 
failure count and the action taken based on elapsed time. 

The Downtime Simulator example that follows uses these Monitor Timing and 
Notification Control parameters: 

changeme 
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The following table explains the Alerting process. Three failed tests must 
accumulate before each Alert is sent. The Maximum Alerts to Send value is set 

to 3. 

 

Looking at the Time values in the table, you will notice that the interval between 
each test is a combination of the Delay Between Tests While: UP value of the 
monitor and the Average Test Duration value of the simulator. In this example, 
it is ten seconds. 

To completely understand the Time column of the Downtime Simulator, you must 
look at the Timing parameters for the monitor. In this example, we have used the 
default setting of 300 seconds for each Monitor State, but the time of each test 
increments by 310 seconds (5m10s). This is easily explained by the following 
arithmetic:: 

¶ 10 second Average Test Duration 
-plus- 

¶ 300 second Delay Between Tests 

The Average Test Duration is used to override the Maximum Test Duration 
timing parameter. 

Please note that in a real world scenario, the numbers in the Time column would 
be much more variable and subsequently more difficult to understand. Variables 
such as the monitor type, network topology, network load, hardware, carrier, and 
latencies all affect the time it takes to perform tests Some tests may return values 
in a few hundred milliseconds, while others may not return values for several 
seconds. 
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What the Downtime Simulator Reports 

The primary purpose of the Downtime Simulator is to test Alert coverage for a 
Monitor at a specific time of day during any day of the week. It does this by 
processing every Action that can be triggered by the Monitor across all Alerts. 
The following text columns help pinpoint problems: 

¶ Queued?. Indicates whether an Action will be attempted or triggered. 

¶ Enabled?.Indicates whether the Action has the appropriate Send Failure 
Notifications or Enable Recovery Action message "checked on". 

¶ Availability OK?. Indicates whether the alert schedule permits the action to 
be triggered during the Day and Time period selected for the Downtime 
Simulator. 

¶ Range OK?.Indicates whether the Alert Range setting corresponds to or 
includes the Alert count number sent by the failing Monitor. Configurable 
Alert Ranges allow you to receive all or only some Alerts when a problem 
occurs. 

Simulator Example of an IIS Restart 

Background for this example: 

¶ We are monitoring an IIS web server using an HTTP Monitor 

¶ An Email Action notifies the web administrator 

¶ A Restart Service Action automatically restarts the IIS Service 

 

Alert Ranges can be used to escalate an action to another administrator or to 
automatically take corrective action when a problem is not resolved quickly 
enough. In this example: 

¶ ipMonitor sends an email to notify the web administrator of the problem 

¶ If the administrator does not respond quickly enough, the IIS Service is 
automatically restarted 

¶ With Send Recovery Notifications enabled for the email Action, the 
administrator will receive an email indicating if the web server has recovered. 
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Bold text indicates that there is a problem with the action. Looking at each of the 
three Failure Notifications sent by the Monitor in this simulation, you can see that 
the Restart IIS action is displayed in bold.. The Action has the Enable Recovery 
Action box checked, and is scheduled for Availability at this time. The Action is 
not Queued, however, due to the fact that its Alert Range value is out of 
bounds. 

The Monitor states the Maximum Alerts to Send is 3. 

 

The problem lies in the Alert Range for the Restart IIS Alert. It is set to 9. 

 

In order for the proper Alert escalation to take place, the Monitor's Maximum 
Alerts to Send would also have to be set to 9. 

Downtime Simulator Tips 

¶ If you specify a Downtime Duration for the Downtime Simulator that is too 
long, you will see more than one and possibly many dark red Lost tests. If 
you specify a duration that is too short, you will not see any Lost tests, and 
the Warn and Down states may also be truncated. 

The Up (green) state shown at the bottom of the Downtime Simulation shows 
Alert information when the monitored resource recovers. 
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The Downtime Simulator configuration parameters can be saved for your account 
upon logging out. Simply hold down the Shift key and click either Logout this 
session or Logout all sessions. 

Mass Edit: Monitor Properties 

When ipMonitor installations range into hundreds or thousands of Monitors, 
manually changing common configuration settings can be time consuming. The 
Mass Edit feature makes it easy to quickly apply large-scale changes to 
configuration fields across any number of Monitors using a rule-based system. 

The Mass Edit feature for Monitor Properties supports: 

¶ Filtering the Monitor List to isolate and edit only specific Monitors. 

¶ Setting any configuration field to a specific value. 

¶ Replacing text in a configuration field. 

¶ Replacing numerical values in a configuration field. 

¶ Using Regular Expressions pattern matching to search and replace. 

¶ Appending numerical or textual strings to any existing value. 

¶ Previewing changes before committing to them. 

¶ Cancelling unwanted changes before they can affect your installation. 

Using the Mass Edit feature, you can: 

¶ Add a prefix string, such as an IP address or machine name, to Monitor 
Names. 

¶ Change the timing parameters of all Monitors, or only of Monitors in a filtered 
subset. 

¶ Quickly update the configuration settings of Monitors created using the 
Network Scan. 

¶ Enable or disable Monitor statistics. 

Accessing the Mass Edit Feature for Monitor Properties 

To access the Mass Edit feature for Monitor Properties: 

1. Log in to the ipMonitor web interface. 

2. Click the Devices tab. 

3. Click Edit > Mass Edit. 

4. Select Monitor Properties. 
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. 

Mass Edit: Tags 

When ipMonitor installations range into hundreds or thousands of Monitors, 
manually changing Custom Tags attached to each Monitor can be time 
consuming. The Mass Edit feature makes it easy to quickly apply large-scale 
changes to Custom Tags across any number of Monitors using a rule-based 
system. 

The Mass Edit feature for Monitor Tags supports: 

¶ Filtering the Monitor List to isolate and edit only Tags attached to specific 
Monitors. 

¶ Renaming Tags. 

¶ Using Regular Expressions pattern matching to search and replace Tag 
content values. 

¶ Appending numerical or textual strings to any existing Tag content value. 

¶ Previewing changes before committing to them. 

¶ Cancelling unwanted changes before they can affect your installation. 

Accessing the Mass Edit Feature for Monitor Tags 

To access the Mass Edit feature for Monitor Tags: 

1. Log in to the ipMonitor web interface. 

2. Click the Devices tab. 

3. Click Edit > Mass Edit. 

4. Select Monitor Tags. 
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Chapter 9 

Group Dependencies 

ipMonitor supports the ability to group together multiple individual Monitors for 
the purposes of assigning them Dependencies. Properly configured Groups and 
Dependencies act as an Alert suppression system in ipMonitor. When a critical 
resource fails, ipMonitor limits Alerts to the Monitor defined as a Dependency 
rather than triggering Alerts for every member Monitor in the Group. 

¶ Group Members are Monitors that make up the Group. 

¶ Group Dependencies are Monitors that must remain available for all 
Members to function correctly. 

Dependencies define the relationship between critical resources and those 
resources that depend on them for all or part of their functionality. A router, 
switch, server computer or stable path to another network would all be valid 
Dependencies. 

Defining Dependency relationships: 

¶ Minimizes the number of redundant Alerts. 

¶ Helps isolate the root cause of the problem. 

¶ Prevents configured Recovery Alerts from attempting to restart services and 
applications if such an action is not required. 

As an example, consider a web solution that is made up of various individual 
components. It would be practical to Group them together and assign certain 
Dependencies to the Group. 
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A logical Dependency would be the network switch. If the switch were to become 
unavailable or fail, all of the Member Monitors for both Groups would be affected 
and many Alerts would be generated. 

By defining the switch Monitor as a Dependency, only the switch failure would 
trigger an Alert. This helps greatly in isolating the root-cause of the problem, 
prevents you from being inundated with a large number of unnecessary Alerts, 
and ensures that Recovery Alerts are not triggered for services and applications 
that do not need to be restarted. 

Dependency Monitors must reach the Down state for ipMonitor to disable alerting 
for Group Members. If the Dependency Monitor is Up, the ability of individual 
Group Members to trigger Alerts remains unaffected. For example, Alerts will be 
processed if hard disk space runs low, an SNMP trap is received, the SQL server 
produces an unexpected query result, and so on. 
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Note: After a Dependency Monitor reaches the Down state, Members that are 
currently in an Up or Warn state will not reach Down or Lost. When all 
Dependencies return to an Up state from a Down state, all alerting functionality is 
restored. 

Groups 

Monitors can be assigned to Multiple Groups 

For example, a PING Monitor that traverses a network switch could be assigned 
as a Dependency to many Groups that depend on the availability of the switch. 

How Monitor State applies to Groups 

A Group will inherit the most critical state of any Monitors, including Dependency 
Monitors, it has been assigned. For example: 

¶ If the State of a single Monitor within a Group changes to Warn, the state of 
the entire Group becomes Warn. 

¶ If the state of that Monitor progresses to Down, the state of the entire Group 
becomes Down. 

The All Managed Devices Group 

The All Managed Devices group is a system group that serves as the parent 
object and container for all ipMonitor devices. 

¶ All newly created devices are automatically added to the All Managed 
Devices group. 

¶ The All Managed Devices group cannot be deleted, nor can ipMonitor be 
configured to operate without it. 

¶ The All Managed Devices group is required for ease of management, and 
acts as the parent for all network devices. 

ipMonitor Installations with More Than 50 Monitors 

Typically, the All Managed Devices group is never assigned to an alert. It is the 
master list and only used to add members to the groups you create. These are 
then assigned to alerts. 

ipMonitor Installations with Less Than 50 Monitors 

The All Managed Devices group may be the only group you require. 
Dependencies can be applied to this group and an alert in order to prevent 
unnecessary actions and help pinpoint problems quickly. 
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The Orphaned Objects Group 

The Orphaned Objects group is a system group that serves as temporary 
container for monitors and groups that do not have valid parent objects. Monitor 
and groups can become orphans when they are imported into ipMonitor with 
missing or invalid XML data. 

To assign an orphaned monitor to an existing device: 

1. Select the orphaned monitor. 

2. Click Move. 

3. Select a device from the Destination Device list and then click Continue. 

4. The monitor is moved and assigned to the destination device. 

To assign an orphaned group to an existing group: 

1. Select the orphaned group. 

2. Click Move. 

3. Select a group from the Destination Group list and then click Continue. 

4. The group is moved and assigned to the destination group. 
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Chapter 10 

Monitor Types 

ipMonitor contains many different types of monitors. We list them here in 
alphabetical order: 

Active Directory IRC 

Bandwidth Usage Kerberos 5 

Battery LDAP 

CPU Usage Link ï User Experience 

DNS User Experience Lotus Notes 

DNS TCP MAPI ï User Experience 

DNS UDP Memory Usage 

Directory Network Speed 

Drive Space NNTP 

Event Log NTP 

Exchange Round-Trip Email Wizard Ping 

Exchange Server 2000/2003 POP3 

Exchange Server 2007 POP3 ï User Experience 

Exchange Server 2010 Printer 

External Process RADIUS 

Fan RWHOIS 

File Property Service 

File Watching SMTP 

Finger SNMP 

FTP SNMP ï User Experience 

FTP User Experience SNMP Trap ï User Experience 

Gopher SNPP 

HTML/ASP SQL: ADO 

HTTP SQL: ADO ï User Experience 

HTTP User Experience SQL Server 

HTTPS TELNET 

Humidity Temperature 

IMAP4 WHOIS 

IMAP4 ï User Experience Windows 

ipMonitor  
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Active Directory 

Active Directory is the directory Service offered in Windows 2000, Windows 2003 
and Windows Vista. It is used to provide a centralized location to store 
information about networked devices, Services and users, as well as a means to 
securely add, modify, delete, and locate data in the directory store. 

Microsoft's Active Directory resolves domain object names to object records 
through Lightweight Directory Access Protocol (LDAP) search or modify 
requests. 

The Active Directory Monitor: 

1. Establishes a connection to the Active Directory service 

2. Sends a Bind Request indicating that it is making a LDAP v2 request 

3. Sends a Search Request asking which LDAP versions the Active Directory 
Service supports 

4. Sends an Unbind Request for the Active Directory server to close the TCP 
connection 

Use the Active Directory Monitor to test that: 

¶ An Active Directory client can open a connection with an Active Directory 
server 

¶ The server adheres to the Active Directory protocol by responding with the 
correct codes 

¶ The server responds within a required number of seconds 

¶ Note: The Active Directory Monitor supports LDAP version 2, which is the 
most commonly supported version. 
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Bandwidth Usage 

The Bandwidth Usage Monitor uses RPC or SNMP communication to measure 
the amount of inbound and outbound traffic traveling through a network interface 
on: 

¶ The local machine 

¶ A remote computer running Microsoft Windows NT, 2000, XP or 2003 

¶ An SNMP-enabled device 

It effectively ensures that: 

¶ The bandwidth rate is tested over time in order to distinguish between a 
steady increase in network usage and a sudden data spike. 

¶ Heavy bandwidth utilization is detected before performance can be affected. 

¶ Administrators are alerted if bandwidth usage exceeds a specified threshold. 

¶ The amount of traffic a resource uses on the network can be determined. 

¶ Request for the ability to configure Bandwidth Monitors to test only the 
incoming or outgoing data rates. 

¶ Ability to monitor the Inbound and Outbound traffic separately. 
 

The Bandwidth Usage Monitor Wizard is designed to help you configure a 
Bandwidth Usage Monitor with the least amount of initial input. There are a 
number of benefits to this approach: 

¶ Configuration is fast and easy, allowing you to get the Monitor up and 
running quickly. 

¶ The Bandwidth Usage Monitor Wizard allows you to test all the parameters 
you enter along the way to make sure that the Monitor will work as expected 
immediately upon being enabled to go live in a production environment. 

Test Results 

When the Monitor is in an Up state, test results are reported as shown in the 
example below: 

¶ in. This value indicates the inbound data received by the server, displayed in 
Kilobytes (KB). 

¶ out. This value indicates the outbound data sent by the server, displayed in 
Kilobytes (KB). 
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¶ KB/s. This value indicates the current amount of bandwidth consumption, 
displayed in KB/s (1024 bytes per second). 

¶ KB/s-avg. This value indicates the average amount of bandwidth 
consumption, displayed in KB/s (1024 bytes per second). This calculation is 
based on the tests performed during the length of time specified in the 
Sample Size field. 

¶ kb/s. This value indicates the current amount of bandwidth consumption, 
displayed in kb/s (1000 bits per second). 

¶ kb/s-avg. This value indicates the average amount of bandwidth 
consumption, displayed in kb/s (1000 bits per second). This calculation is 
based on the tests performed during the length of time specified in the 
Sample Size field. 

¶ Total Bandwidth (Inbound + Outbound) 

When the Monitor is in a Warn, Down, or Lost state, the Last Result field 
indicates the problem encountered. 
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Battery 

The Battery Monitor uses SNMP communication to test the remaining charge in a 
UPS battery. The Monitor's ability to retrieve and analyze data allows an 
Administrator to:  

¶ Be notified when a power outage occurs.  

¶ Stay aware of the remaining charge in the battery.  

¶ Obtain an accurate picture of battery health and current operational 
conditions.  

In order to extend the running time of necessary servers or components, critical 
decisions can be made using this information. 

Test Results 

When the Monitor is in an Up state, test results are reported as shown in the 
example below: 

¶ capacity. This value indicates the current capacity of the UPS battery being 
monitored, shown as a percentage. 

When the Monitor is in a Warn, Down, or Lost state, the Last Result field 
indicates the problem encountered. 
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CPU Usage 

The CPU Usage Monitor uses Local or SNMP communication to test the amount 
of processor capacity available on: 

¶ The local machine  

¶ A remote computer running Microsoft Windows NT, 2000, XP or 2003  

¶ A remote computer running a Unix-Based Operating System such as Linux, 
Solaris, HP-UX, and so on.  

¶ An SNMP-enabled device  

It effectively ensures that: 

¶ Heavy, sustained CPU utilization is quickly detected before performance can 
be affected.  

¶ Administrators are alerted if the CPU utilization exceeds the specified 
threshold. 

Test Results 

When the Monitor is in an Up state, test results are reported as shown in the 
example below: 

¶ usage. This value indicates the CPU load currently on the system, 
represented as a percentage (%). 

¶ usage-avg. This value indicates the average CPU load on the system, 
represented as a percentage (%). It is based on the tests performed during 
the length of time specified in the Sample Size field. 



ipMonitor Ö Administration Guide 
 

 
Monitor TypesÖ 89 

DNS User Experience 

The DNS User Experience Monitor tests the ability of a Primary and the 
Secondary DNS server to respond to a record query, as well as its level of 
responsiveness. 

This monitor uses the Universal Datagram Protocol(UDP), which is the primary 
method of communication with DNS servers. The monitor alternately queries 
both the Primary and the Secondary DNS server for a Domain Name until one of 
the DNS servers responds, or the "Maximum Test Duration" time expires. 

The results of the Domain Name resolutions are compared against a list of 
expected IP addresses. Results are verified in one of two ways:  

¶ The result set must include all of the IP addresses in the "expected" list  

¶ The result set must have at least one of the IP addresses in the "expected" 
list  

The monitor considers the test to have failed:  

¶ If the above noted tests fail 
-or-  

¶ If both DNS Servers fail to respond within the "Maximum Test Duration"  

The monitor tests:  

¶ That at least one DNS server is "up and running"  

¶ That the Primary DNS server, Secondary DNS server or both are able to 
respond to a Domain Name Query, perform a lookup and resolve a 
hostname  

¶ That the results of the resolved Domain Name correctly corresponds to the 
IP address you expect  

¶ That the complete round trip time until the response is received is within a 
specific number of seconds 
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DNS TCP 

The DNS TCP Monitor tests a DNS Server's ability to respond to a record query, 
as well as its level of responsiveness.  

This monitor uses the Transmission Control Protocol (TCP), which is the 
secondary method of communication for DNS Servers. As TCP establishes a 
connection, guarantees delivery of data and also guarantees that packets will be 
delivered in the same order in which they were sent, it is considered less efficient 
for the purpose of DNS. TCP is typically used only when the response data size 
exceeds 512 bytes, or for such tasks as zone-transfer request in DNS over TCP 
(AXFR). 

The monitor measures round trip time by sending a query for thea root server A 
Record, a.root - servers.net , to the specified DNS Server and then waiting for 

a response. 

The Monitor test will pass if the Monitor receives a valid positive or negative 
response within the required timeout period. 

The DNS TCP Monitor tests that the: 

¶ DNS Server is "up and running"  

¶ DNS Server is able to process and respond to a query  

¶ Response makes a complete round trip within a specific number of seconds 
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DNS UDP 

The DNS UDP Monitor tests a DNS Server's ability to respond to a record query, 
as well as its level of responsiveness.  

The DNS UDP Monitor uses the Universal Datagram Protocol, which is the 
primary method of communication with DNS Servers. 

ipMonitor measures round trip time by sending a query for the root server A 

record, a.root - servers.net , to the specified DNS Server and then waiting for a 

response. 

The Monitor test will pass if the Monitor receives a valid positive or negative 
response within the required timeout period. 

The DNS UDP Monitor tests that the: 

¶ DNS Server is "up and running"  

¶ DNS Server is able to process and respond to a query  

¶ Response makes a complete round trip within a specific number of seconds 
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Directory 

The Directory Monitor detects modifications to a directory's basic structure and 
alerts you when changes outside of specified bounds are detected. The Monitor 
tests various properties of a given directory, making it ideal for: 

¶ Verifying the existence of a directory.  

¶ Determining whether files have been added to or removed from a directory.  

¶ Determining whether the size of a directory has changed.  

¶ Monitoring subdirectories for modifications to their overall size or file count.  

The Directory Monitor tests the structure and content of a directory at regular 
intervals to detect any changes outside the boundaries you define. When a 
change is encountered, the Monitor can trigger: 

¶ A Failure Notification Alert.  

¶ An Information Alert.  

¶ Both a Failure Notification Alert and an Information Alert.  

Configuring Information Alerts is an optional process. Separating Information 
Alerts from Monitoring actions and Failure Notifications allows you to instruct the 
Monitor to send an Information Alert but remain in an Up state even if a change is 
detected. This gives you maximum flexibility to configure each Directory Monitor 
to meet your specific needs for every directory being tested. 

This Monitor is particularly useful for tasks such as: 

¶ Monitoring allotted storage space in a user directory.  

¶ Detecting whether critical files have been removed from a directory.  

¶ Ensuring required backups are always completed.  

¶ Monitoring files that could potentially grow large enough to impact disk 
space.  

¶ Monitoring directories containing files that are likely to grow and multiply at a 
rapid rate. 
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Drive Space 

The Drive Space Monitor uses RPC or SNMP communication to test the amount 
of available drive space on a specified drive, share or mount. If less available 
space than specified is detected, a failure state occurs. 

Using the RPC communication method, the Drive Space Monitor can monitor any 
host machine running:  

¶ Windows NT  

¶ Windows 2000  

¶ Windows XP  

¶ Windows 2003  

Using the SNMP communication method, the Drive Space Monitor can monitor 
any SNMP-enabled host machine running: 

¶ Windows NT/2000/XP/2003  

¶ UNIX and UNIX-like Operating Systems such as Linux, Solaris, HP-UX, and 
so on  

Common uses of the Drive Space Monitor are: 

¶ Ensuring critical resources do not run out of drive space.  

¶ Automatically taking Recovery actions to free up drive space. 

Note1: For Windows NT, comparison is made in relation to the drive size that 
hosts the UNC share. For Windows 2000, comparison is made in relation to the 
drive size that hosts the UNC share unless a disk space quota has been set for 
the share. In this case, comparison is made relative to the size of the quota. 

Note2: The Drive Space Monitor Wizard allows you to configure Drive Space 
Monitors quickly and easily. However, if you prefer greater control over the 
process, you can Clone an existing Drive Space Monitor and make any required 
configuration changes manually. 

Test Results 

¶ space. The current available space on the share being monitored. Available 
space is reported in gigabytes (gb) and megabytes (mb). 

¶ avail. The current available space on the share being monitored, reported as 
a percentage (%) of the entire drive. 
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Event Log 

The Event Log Monitor can be used to locate information within Error, Warning, 
Information, Success Audit and Failure Audit events that are recorded in the 
Windows event logs. 

For any Server or Workstation version of Windows:  

¶ Application log  

¶ Security log  

¶ System log  

Additional logs for computers running as a Domain Controller:  

¶ Directory service log  

¶ File Replication service log  

Additional logs for computers running as a Domain Name System Server:  

¶ DNS server log  

The Event Log Monitor uses header information to locate specific events, 
however, the Description is often the most useful piece of information, as it 
indicates what occurred or the significance of the event. 

As the format and contents of the event description vary depending on the event 
type, the Event Log Monitor requires a Regular Expression to filter specific 
details from the description field. This can be a simple RegEx that captures the 
entire contents of the description field, or a more sophisticated RegEx to filter 
only specific parameters. 

The events table only shows ipMonitor events relating to the status of the 
monitor. It does not display the events captured by the Windows Event Log 
monitor. 
If you need to see a history of the events captured by the Windows Event Log 
monitor, you can create a Text Log action to record the Information Messages 
that the monitor generates. 
To add a Text Log action to an alert: 

1. Click the Configuration tab, and then click Alert List. 

2. Click an alert. 

3. Click Text Log from the Add Actionmenu. 

4. Type Text Log Action in the Action Namefield. 
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5. Type the file name and directory for the log file in the File Name and 
Directory fields. For example: 
eventlog.txt 
C:\ 

6. Check Send Information Messages 

7. Click OK. 

Note 1: Tests on Event Log Monitors Differ from other Monitors 

When creating a new Event Log Monitor, note that the Monitor starts searching 
forward from the time of creation; it does not search historical content already in 
the Event log file. 

When configuring Monitors, suspending and then unsuspending a Monitor is 
often used to force an immediate test. This will not work with the Event Log 
Monitor as its pointer will be reset to its current time or, essentially, the end of the 
log file. A real Event will need to occur for the Monitor to send an Information 
Alert. 

The Preview test, however, does search the Event Log's existing content, making 
it ideal for configuration and troubleshooting purposes. 

Note 2: Recommended Default Timing Interval 

We recommend using the default timing intervals of 300 seconds between scans. 
This is because the Event Log Monitor queries the Event Log via the WMI 
Service, and this Service may consume a considerable amount of resources on 
the target machine. 300 seconds between scans allows for a balance between 
the length of time it takes to query the Event Log and the load placed on the 
target machine's CPU. 

IMPORTANT! Setting the timing intervals to a value lower than 180 seconds can 
cause problems related to security and authentication, particularly in scenarios 
where multiple Event Log Monitors target a single machine using a Credential 
impersonating a Domain Account. 
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Exchange Round-Trip Email Wizard 

The Exchange Round-Trip Email Wizard is designed to help you configure an 
IMAP4, POP3, or MAPI User Experience Monitor with the least amount of initial 
input. There are a number of benefits to this approach: 

¶ Configuration is fast and easy, allowing you to get the Monitor up and 
running quickly. 

¶ The Exchange Round-Trip Email Wizard allows you to test all the parameters 
you enter along the way to make sure that the new Monitor will work as 
expected immediately upon being enabled to go live in a production 
environment. 

IMPORTANT! Before creating a MAPI User Experience Monitor using the 
Exchange Round-Trip Email Wizard, please note that the monitor requires: 

¶ Access to the messaging subsystem of Microsoft Outlook. 
Note: A full version of Microsoft Outlook that supports the MAPI protocol 
must be installed on the ipMonitor server for this purpose. However, the 
Microsoft Outlook application itself does not need to be running in order for 
the Monitor to function correctly. 

¶ A Microsoft Outlook Email Account to exist under the default Mail Profile of 
the Windows User Account impersonated by the Monitor. 
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 Exchange Server 2000/2003 

The Exchange Server 2000/2003 Monitor opens a connection to the specified 
Exchange server and tests the performance of its subsystems to determine the 
server's general health. The overall performance of the server is typically dictated 
by its weakest performing subsystem.  

The Monitor's ability to retrieve and analyze data allows an Administrator to: 

¶ Use preconfigured performance counters made available by the Windows 
Management Instrumentation service to test multiple Exchange Sever 
subsystems at once. 

¶ Quickly identify any performance degradation in critical Exchange Server 
components. 

¶ Determine the exact point of failure. 

¶ Take corrective action before email outages occur. 

¶ Note: There is a separate monitor type for Exchange Server 2007. 

 Exchange Server 2007/2010 

The Exchange Server 2007/2010 Monitor opens a connection to the specified 
Microsoft® Exchange 2007/2010 server and tests the performance of its 
subsystems to determine the server's overall health. 

The Monitor's ability to retrieve and analyze data allows an Administrator to: 

¶ Use preconfigured performance counters made available by the Windows 
Management Instrumentation service to test multiple Exchange Sever 
subsystems at once. 

¶ Quickly identify any performance degradation in critical Exchange Server 
components. 

¶ Determine the exact point of failure. 

¶ Take corrective action before email outages occur. 

Available performance counters: 

Aggregate Delivery Queue Length (All Queues) 

Aggregate Delivery Queue Length (All Queues) is the number of items 
queued for delivery in all queues.. 
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Active Non-SMTP Delivery 

Active Non-SMTP Delivery Queue Length is the number of items in the active 
Non-SMTP queues. 

Active Mailbox Delivery 

Active Mailbox Delivery Queue Length is the number of items in the active 
mailbox queues.  

Active Remote Delivery Queue Length 

Active Remote Delivery Queue Length is the number of items in the active 
remote delivery queues.  

Messages Queued for Submission 

The Messages Queued for Submission performance counter indicates the 
number of messages in the mailbox store that are ready to be sent and are 
waiting to be submitted to a transport server.  

Poison Queue 

The Poison Queue Length performance counter measures the number of 
messages currently in the poison queue. Messages in the poison message 
queue are in a permanently suspended state. 

Replication Receive Queue Size 

The Replication Receive Queue Size performance counter indicates the 
number of public folder replication messages waiting to be processed. 

The larger the replication queue becomes, the more out of 
synchronization the content in the folders becomes. When replication 
queues grow, there is an increased load on resources as the messages 
in the replication queue are processed. Also, growing replication queues 
indicate that public folder content on the server is outdated. 

Retry Remote Delivery 

The Retry Remote Delivery Queue Length performance counter measures 
the number of messages currently in the retry remote delivery queue. 
Messages in this queue are in a retry state because there an issue prevented 
their delivery. If the issue is transient, a subsequent reattempt to send the 
message may be successful.  

Messages that cannot be successfully delivered are subject to various retry, 
resubmit, and expiration deadlines based on the message's source and 
destination. The message is said to "time-out", or expire, after all delivery 
efforts have failed during a specified period of time. After a message expires, 
the sender is notified of the delivery failure. Then the message is deleted 
from the queue. 
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Submission Queue Length 

The Submission Queue Length performance counter measures the number 
of messages currently in the submission queue. Messages in this queue are 
in a retry state because an issue prevented their submission to the 
categorizer. If the issue is transient, a subsequent attempt to submit the 
message may be successful. 

Unreachable Queue Length 

The Unreachable Queue Length performance counter measures the number 
of messages currently in the retry mailbox delivery queue. Messages in this 
queue are in a retry state because an issue prevented their delivery. If the 
issue is transient, a subsequent attempt to send the message may be 
successful. 

 

WMI Requirements 

In order for the Exchange Server Monitor to be able to properly monitor an 
Exchange Server, Windows Management Instrumentation (WMI) must be 
enabled and functioning properly. In addition, the remote server must be 
accessible through an RPC connection in order to run the WMI queries. 

Counters are tested in the order that they appear. In the event of multiple counter 
failures, only the first counter error encountered will be reported. 

The Exchange Server Monitor's built-in internal sampling helps combat counter 
spikes. The Monitor will issue the WMI query five times, once every second, and 
then calculate an average based on the query results. 

Troubleshooting WMI 

1. As remote WMI connections use RPC, the RPC Service must be enabled 
and started on the remote system 

a. Logon to the remote system. 

b. Open the Windows Services list on that system. 

c. Ensure that the "Remote Procedure Call (RPC)" service is enabled and 
started. 

2. As WMI also uses DCOM to communicate with the remote system, it must be 
enabled and configured correctly on the remote system. 
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a. Log on to the target server with an administrator account. 

b. Navigate to Start > Control Panel > Administrative Tools > Component 
Services. You need to switch to the Classic View of the Control Panel to 
use this navigation path. 

c. Expand Component Services > Computers. 

d. Right-click My Computer, and then select Properties. 

e. Select the COM Security tab, and then click Edit Limits in the Access 
Permissions grouping. 

f. Ensure the user account you want to use to Monitor resources over  WMI 
has Local Access and Remote Access, and then click OK. 

g. Click Edit Default, and then ensure the user account you want to use to 
Monitor resources over WMI has Local Access and Remote Access. 

h. Click OK. 

i. Click Edit Limits in the Launch and Activation Permissions grouping. 

j. Ensure the user account you want to use to Monitor resources over  WMI 
has Local Launch, Remote Launch, Local Activation, and Remote 
Activation, and then click OK. 

k. Click Edit Default, and then ensure the user account you want to use to 
Monitor resources over WMI has Local Launch, Remote Launch, Local 
Activation, and Remote Activation. 

l. Click OK. 

3. Verify WMI Security to ensure that the account used by the ipMonitor 
Credential can access the CIMV2 namespace. 

a. Log on to the computer you want to monitor with an administrator 
account. 

b. Navigate to Start > Control Panel > Administrative Tools > Computer 
Management > Services and Applications. You need to switch to the 
Classic View of the Control Panel to use this navigation path. 

c. Click WMI Control, and then right-click and select Properties. 

d. Select the Security tab, and then expand Root and click CIMV2. 

e. Click Security and then select the user account used to access this 
computer and ensure you grant the following permissions: 

¶ -Enable Account 

¶ -Remote Enable 
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f. Click Advanced, and then select the user account used to access this 
computer. 

g. Click Edit, select This namespace and subnamespaces in the Apply to 
field, and then click OK. 

h. Click OK on the Advanced Security Settings for CIMV2 window. 

i. Click OK on the Security for Root\CIMV2 window. 

j. Click Services in the left navigation pane of Computer Management. 

k. Select Windows Management Instrumentation in the Services result 
pane, and then click Restart. 

4. If you are monitoring a target in a workgroup, you need to disable remote 
User Account Control (UAC).  This is not recommended, but it is necessary 
when monitoring a workgroup computer. Disabling remote user account 
control does not disable local user account control functionality. 

Warning: The following procedure requires the modification or creation of a 
registry key. Changing the registry can have adverse effects on your 
computer and may result in an unbootable system. Consider backing up your 
registry before making these changes. 

a. Log on to the computer you want to monitor with an administrator 
account. 

b. Click Start > Accessories > Command Prompt. 

c. Enter regedit . 

d. Expand the following registry key: 
HKEY_LOCAL_MACHINE\ SOFTWARE\ Microsoft \ Windows \ Cur rentVersio

n\ Policies \ System \  

e. Locate or create a DWORD entry named LocalAccountTokenFilterPolicy 
and provide a DWORD value of 1. 

Note: To re-enable remote UAC, change this value to 0.  

5. If the target computer has Windows Firewall enabled, it must have a Remote 
WMI exception to allow remote WMI traffic through 
(http://msdn.microsoft.com/en-us/library/aa389286(VS.85).aspx). 
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a. Click Start, click Run, type cmd and then press ENTER. 

b. Type netsh firewall set service RemoteAdmin enable at the command 
prompt, and then press ENTER. 

c. Type exit at the command prompt, and then press ENTER. 

 External Process 

The External Process Monitor launches an external program or script. It can also 
launch a script via an executable program, such as: 

¶ PuTTY Link plink.exe  

¶ Windows cscript.exe  

Any required command line parameters can be passed to the third party 
executable on startup. 

The External Process Monitor is very versatile and typically used by 
administrators to: 

¶ Simplify routine or repetitive tasks. 

¶ Create custom Monitors to work with ipMonitor. 

The External Process Monitor supports two modes of operation: 

¶ Process Return Value. The third party executable reports an "exit" code to 
the ipMonitor process in the form of a numeric value. 

¶ Environment Variable. The third party executable sets the value of an 
"environment variable" to be read by the Monitor. 

When configured using Process Return Value mode, the test passes if: 

¶ The program finishes executing within the Maximum Test Duration timeout 
interval. 

¶ The "exit" code returned matches the Expected Return Value. 

When configured using Environment Variable mode, the test passes if: 

¶ The program finishes executing within the Maximum Test Duration timeout 
interval. 

¶ The Monitor was able to read the Environment Variable in question and 
determined its value is correct. 

Analysis of Test Results 

The External Process Monitor supports two modes of operation: 
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¶ Analyze a Process Return Value 

¶ Analyze an Environment Variable 

Process Return Value 

The third party executable reports an "exit" code to the ipMonitor process in the 
form of a numeric value. 

 

When the third party executable or script is created, it must be designed to 
produce an exit code when it shuts down. 

Although exit codes can be any number you choose in your program design, "0" 
is a standard Success exit code used when an executable returns the expected 
value. 

In our example, if the target log file did not exist we would return "1" to the 
ipMonitor process on exit. This result would not match the Expected Return 
Value, therefore causing the External Process Monitor test to fail. 

Alternatively, if a "0" was returned, the result would be a match and the External 
Process Monitor would continue in an Up state. 

Environment Variable 

The third party executable sets the value of an Environment Variable, which is 
subsequently read by the External Process Monitor. 

 

Environment Variables allow for greater flexibility in the information that can be 
passed, especially when the content must contain file paths, or special 
characters such as less than or greater than symbols. 
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After setting the value of the Environment Variable, the third party executable or 

script must call signal_env.exe  in order for the variable to be available to the 

ipMonitor process. 

The signal_env.exe tool is located in the root folder of the ipMonitor installation. 

These steps describe how signal_env.exe  works: 

1. The application or script being monitored is run. 

2. During execution, the application sets the necessary Environment Variable 

and then calls signal_env.exe . 

3. The External Process Monitor reads the Environment Variable and performs 
a comparison based on the Monitor configuration. 

In this example, ipMonitor expects "result " to equal "su ccessful " for the test to 

pass. Any other text string will cause the test to fail. 

The following diagram shows the third party executable or script environment: 
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The diagram illustrates that: 

¶ The ipMonitor executable is running under the IPM account. 

¶ A Credential named LOG was created to impersonate an account with the 
necessary permissions. 

¶ ipMonitor impersonates the LOG Account to run the third party program. 

¶ When the third party executable runs, it calls signal_env.exe to communicate 
back to ipMonitor that it was run under the LOG account context. 

¶ ipMonitor retrieves the LOG environment variables for comparison. 

In the Windows NT, 2000, XP, 2003 and Vista Operating Systems, Environment 
Variables are grouped internally into four categories: 

¶ SYSTEM Variables define the behavior of the global operating system 
environment. These apply to all users of the machine and are recorded in the 
Registry at: HKLM\System\CurrentControlSet\Control\Session 
Manager\Environment. 

¶ PROCESS Variables define the environment in which a process runs. These 
apply to the current process, and may be passed on to child processed. 
PROCESS variables are not stored in the Registry. 

¶ USER Variables are only available when the user is logged on to the 
machine. Local variables set in the HKEY_CURRENT_USER hive are valid 
only for the current user. These are recorded in the Registry at 
HKCU\Environment. 

¶ VOLATILE Variables are created during logon script execution. These apply 
to the current logon session and are recorded in the Registry at 
HKCU\VolatileEnvironment. 

Note: ipMonitor is able to set only PROCESS Environment Variables to launch a 
script or executable via the External Process Monitor or External Process Alert. 

The External Process Monitor can be configured to determine test success or 
failure by reading a PROCESS Environment Variable rather than basing its 
status on the script or executable's exit code. 

Note1: If the third party executable or script fails to finish within the Maximum 
Test Duration interval, ipMonitor will terminate the process. 

Note2: We recommend that the third party executable be located on the same 
machine that hosts ipMonitor. The third party executable or script runs in the 
memory space and environment of the ipMonitor host machine. Even if it is called 
across the network using a UNC path, it still runs locally.  
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Test Results 

¶ return. The numeric "exit code" reported by the third party executable. 
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Fan 

The Fan Monitor uses SNMP communication to test the current status of a fan. 
The Monitor's ability to retrieve and analyze the response received from a fan 
allows an Administrator to: 

¶ Be notified when the fan is not functioning as expected. 

¶ Ensure that server temperature remains within safe operating limits. 

¶ Obtain an accurate picture of current fan health. 

Using this information, fan degradation can be immediately detected and dealt 
with in a timely manner before it can impact critical servers or other network 
components. 

The Fan Monitor Wizard is designed to help you configure a Fan Monitor with the 
least amount of initial input. There are a number of benefits to this approach: 

¶ Configuration is fast and easy, allowing you to get the Monitor up and 
running quickly. 

¶ The Fan Monitor Wizard allows you to test all the parameters you enter along 
the way to make sure that the Monitor will work as expected immediately 
upon being enabled to go live in a production environment. 

Note1: The Humidity, Temperature, Battery and Fan Monitors' default Delays 
Between Tests While: Up, Warn, Down and Lost settings are slightly different 
from those of other Monitor types. Due to the high potential for disaster when 
abnormal conditions are detected, these default settings have been lowered from 
300 seconds to 60 seconds between tests. 

Note2: The Fan Monitor Wizard allows you to configure Fan Monitors quickly and 
easily. However, if you prefer greater control over the process, you can Clone an 
existing Fan Monitor and make any required configuration changes manually. 
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File Property 

The File Property Monitor detects modifications made to a file and alerts you 
when changes outside of specified bounds are detected. The Monitor tests 
various properties of a given file, making it ideal for: 

¶ Verifying the existence of a file. 

¶ Determining whether a file has been modified. 

¶ Determining whether the size of a file has changed. 

¶ Detecting changes in a file's checksum value. 

The File Property Monitor tests the existence  and properties of a file at regular 
intervals to detect any changes outside the boundaries you define. When a 
change is encountered, the Monitor can trigger: 

¶ A Failure Notification Alert. 

¶ An Information Alert. 

¶ Both a Failure Notification Alert and an Information Alert. 

Configuring Information Alerts is an optional process. The separation of Alerting 
actions from Monitoring actions allows you to instruct the Monitor to send an 
Information Alert but remain in an Up state even if a change is detected. This 
gives you maximum flexibility to configure each File Property Monitor to meet 
your specific needs depending on the type of file being tested. 

Test Results 

¶ size. The current available space on the share being monitored. Available 
space is reported in gigabytes (gb) and megabytes (mb).. 
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File Watching 

The File Watching Monitor reads file content one line at a time, making it ideal for 
locating various types of information recorded in application or server log files, 
such as errors, events and notices. 

Syslog files, which are sent across the network to a Syslog Server rather than 
being recorded locally, can also easily be monitored using the File Watching 
Monitor. 

The File Watching Monitor scans the file you specify to locate any entries that 
match the regular expressions you have defined. Regular expression searching 
is ideal for filtering specific details from the lines in a file, because the format and 
contents in log files may vary significantly depending on the information 
recorded. 

When a match is found, a Content Generator that you configure parses the 
information, and then an Information Alert is triggered. 

The File Watching Monitor may be configured to only trigger a single Information 
Alert per scan, as opposed to one per match, which can significantly reduce the 
number of Alerts you receive. 

The File Watching Monitor maintains a pointer to the file offset, ensuring that 
lines are only analyzed once. Should the log file be reset, the pointer will also be 
reset. 

Note: When creating a new File Watching Monitor, note that the Monitor starts 
searching forward from the time of creation; it does not search historical content 
already in the file. 

While configuring a Monitor, clicking the Force Test button will reset the testing 
cycle for the Monitor, allowing you to promptly reapply new configuration 
parameters. However, this will not work with the File Watching Monitor as its 
pointer will be reset to its current time or, essentially, the end of the file. 

The Preview test, however, does search the file's existing content, making it 
ideal for configuration and troubleshooting purposes. 

Example 

Most servers and server applications are capable of recording system errors to a 
log file. ipMonitor can be used to search through the contents of a log file for 
specific entries based on user-defined criteria, or a Regular Expression. 

When a match is found, this information can be extracted from the file and 
formatted using a Content Generator before it is sent to an Information Alert. 



 
110 Ö Monitor Types 

Sample Line in Syslog :: Cisco PIX Firewall 

Jul 29 2004 09:56:27: %PIX - 1- 103003: (Primary) Other firewall 

network interface 4 failed.  

Monitor Configuration Settings 

 

File Name: pix _syslog.log  

Directory: \ \ SYSLOGSRV\ logs \  

Scenario #1: RegEx Pattern \ i(.*?) \ : \ s+ \ %PIX\ - 1- 103003: \ s+(.*?)  

Content Generator 

After the configuration settings are applied, it will then be necessary to create a 
Content Generator to insert the results into an email message body or other 
action type when an action is triggered. A Content Generator is created in the 
Alerts / Content Generators section. 

 
















































































































































































































































